
1

Part 1: Introduction to Geographic Information Systems (GIS)

ICIMOD Manual 2017/11

Training Manual on

Application of Remote Sensing and 
Geographic Information Systems for 
Mapping and Monitoring of Glaciers
Part 2 - Glacier Database Generation using ArcGIS



2

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part 2: Glacier Database Generation using ArcGIS

About ICIMOD

The International Centre for Integrated Mountain Development, ICIMOD, is a regional 

knowledge development and learning centre serving the eight regional member countries 

of the Hindu Kush Himalaya – Afghanistan, Bangladesh, Bhutan, China, India, Myanmar, 

Nepal, and Pakistan – and based in Kathmandu, Nepal. Globalisation and climate 

change have an increasing influence on the stability of fragile mountain ecosystems and 

the livelihoods of mountain people. ICIMOD aims to assist mountain people to understand 

these changes, adapt to them, and make the most of new opportunities, while addressing 

upstream-downstream issues. We support regional transboundary programmes through 

partnership with regional partner institutions, facilitate the exchange of experience, and serve 

as a regional knowledge hub. We strengthen networking among regional and global centres 

of excellence. Overall, we are working to develop an economically and environmentally 

sound mountain ecosystem to improve the living standards of mountain populations and to 

sustain vital ecosystem services for the billions of people living downstream – now, and for 

the future. 

ICIMOD gratefully acknowledges the support of its core donors: the 
Governments of Afghanistan, Australia, Austria, Bangladesh, Bhutan, China, 
India, Myanmar, Nepal, Norway, Pakistan, Sweden, and Switzerland.

Corresponding author: Sudan Bikash Maharjan    sudan.maharjan@icimod.org



iii

Part 1: Introduction to Geographic Information Systems (GIS)

Training Manual on
Application of Remote Sensing and 
Geographic Information Systems for  
Mapping and Monitoring of Glaciers
Part 2 - Glacier Database Generation using ArcGIS

International Centre for Integrated Mountain Development, Kathmandu, December 2017

Authors

Sudan Bikash Maharjan, Finu Shrestha, Samjwal Ratna Bajracharya

ICIMOD Manual 2017/11



iv

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part 2: Glacier Database Generation using ArcGIS

Copyright © 2017
International Centre for Integrated Mountain Development (ICIMOD)
All rights reserved. Published 2017

Published by
International Centre for Integrated Mountain Development 
GPO Box 3226, Kathmandu, Nepal

ISBN	 978 92 9115 553 8 (printed)

	 978 92 9115 552 1 (electronic)

LCCN	 2017–322015

Production team
Bill Wolfe (Consultant editor)
Christopher Butler (Editor)
Dharma R Maharjan (Layout and design)
Asha Kaji Thaku (Editorial assistant)

Cover image: Landsat image of Bhutan

Printed and bound in Nepal by
Hill Side Press (P) Ltd., Kathmandu, Nepal

Note
This publication may be reproduced in whole or in part and in any form for educational or non-
profit purposes without special permission from the copyright holder, provided acknowledgement 
of the source is made. ICIMOD would appreciate receiving a copy of any publication that uses this 
publication as a source. No use of this publication may be made for resale or for any other commercial 
purpose whatsoever without prior permission in writing from ICIMOD.

The views and interpretations in this publication are those of the author(s). They are not attributable to 
ICIMOD and do not imply the expression of any opinion concerning the legal status of any country, 
territory, city or area of its authorities, or concerning the delimitation of its frontiers or boundaries, or 
the endorsement of any product.

This publication is available in electronic form at www.icimod.org/himaldoc

Citation: Maharjan, S.B., Shrestha, F. & Bajracharya, S.R. (2017) Training manual on application of 
remote sensing and geographic information systems for mapping and monitoring of glaciers:  
Part 2: Glacier database generation using ArcGIS. ICIMOD Manual 2017/11. Kathmandu: ICIMOD



v

Part 1: Introduction to Geographic Information Systems (GIS)

Contents

Acknowledgements	 v
Acronyms and Abbreviations	 vi
About the Manual	 vii

1.	 Introduction to Geographic Information Systems	 1
	 1.1	 Functions of GIS	 3

Data Acquisition and Preprocesing	 3
Database Management, Update and Retrieval	 3
Spatial Modeling, Measurement and Analysis	 3
Presenting Results – Graphical Output and Visualization	 3

	 1.2	 Fundamental Data Types Used in GIS	 3
Raster Data	 4
Vector Data	 4
Attribute Data	 6

	 1.3	 Coordinate Systems	 7
Geographic Coordinate System (GCS)	 7
Projected Coordinate System (PCS)	 8

	 1.4	 Map Projection System	 10
Properties of Map Projection	 10
Types of Projections	 11
Map Projection Parameters	 15

2.	 Introduction to ArcGIS	 17
	 2.1	 ArcCatalog	 19

Exercise in ArcCatalog	 19
Create New Shapefile – ArcCatalog	 21

	 2.2	 ArcMap	 24
Getting Started with ArcMap	 24
Adding Data to ArcMap	 27
Using the Main Tools	 29
Selecting Features	 30
Setting Map Units, Display Units and Map Projection	 30
Measuring in the Map Display	 31
Symbolizing Features	 32
Saving ArcMap Projects	 34
Working with Attribute Table and Link to Other Tabular Data	 34
Analysis in the Map Display	 41
Labeling Features	 49
Querying Data	 50
Map Layouts	 53
Export or Print the Map	 63

	 2.3	 ArcToolbox and Extensions in ArcGIS	 64
ArcToolbox	 65
Geoprocessing through ArcToolbox	 65
Extensions in ArcGIS	 71
Spatial Analyst	 71



vi

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part 2: Glacier Database Generation using ArcGIS

3.	   Calculation of Geo-Statistical Database of Glaciers	  79
	 3.1	 Assign the Local ID	 81
	 3.2	 GLIMS ID	 83
	 3.3	 Glacier Area	 87
	 3.4 	 Glacier Elevation	 88
	 3.5	 Glacier Slope	 91
	 3.6	 Hypsography of Glaciers	 93

4.	 References	 101



vii

Part 1: Introduction to Geographic Information Systems (GIS)

Acknowledgements

The framework and draft manual were prepared in 2010, and used in several trainings on the Application of 
Remote Sensing and Geographic Information Systems in the Mapping and Monitoring of Glaciers since 2010. 
Representatives from the Department of Hydrology and Meteorology (DHM), the Water and Energy Commission 
Secretariat (WECS), Kathmandu University (KU), and Tribhuvan University (TU), Nepal, participated in these trainings. 
This manual was also used in regional training courses organized at the National Center for Remote Sensing and 
Geo-Informatics Institute of Space Technology, Karachi, India, in October 2014; Sherubtse College, the Royal 
University of Bhutan, in March 2015; the Department of Hydro-Met Services, the Royal Government of Bhutan, in 
November 2015; and the Department of Meteorology and Hydrology, Ministry of Transport and Communications, 
Myanmar, in July 2016. To date, 10 trainings have been conducted using this manual, including six in Nepal 
and four in the region. The manual has been updated continuously, incorporating feedback received from training 
participants and resource persons associated with each session, resulting in its considerable improvement. We thank 
everyone for their feedback and assistance. 

We also wish to thank to Gauri Shankar Dangol and Dharma Ratna Maharjan of ICIMOD for their untiring support 
in the preparation of graphics, figures, and tables. 

Special thanks go to Pradeep Mool, former programme coordinator of the Cryosphere Monitoring Project, 
Manchiraju Sri Ramachandra Murthy, former theme leader of Geospatial Solutions, Arun Bhakta Shrestha, 
programme manager of River Basins, and Mir Matin, theme Leader of Geospatial Solutions, for their encouragement 
and support. 

We wish to express our gratitude to all the officials and staff members who helped and contributed to the 
Cryosphere Monitoring Project under the Norwegian Ministry of Foreign Affairs. Landsat data were provided 
courtesy of NASA and the United States Geological Survey (USGS). The Shuttle Radar Topography Mission (SRTM) 
digital elevation model version was provided courtesy of NASA’s Jet Propulsion Laboratory and further processed by 
the Consultative Group for International Agriculture Research (CGIAR).

Finally, we wish to take this opportunity to express our gratitude to our immediate colleagues associated with 
ICIMOD’s Geospatial Solutions, MENRIS, and Cryosphere Initiative teams for their support, strength, and 
cooperation, which were essential to the successful completion of this work.



viii

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part 2: Glacier Database Generation using ArcGIS

Acronyms and Abbreviations

AM Ante meridiem

BLOBs Binary Large Objects

CAD Computer-aided design

CGIAR Consultative Group on International Agricultural Research 

DB Database 

DEM Digital Elevation Model 

DHM Department of Hydrology and Meteorology, Nepal

DMS Degree Minutes Seconds

ESRI Environmental Systems Research Institute

GCS Geographic Coordinate System 

GIS Geographic Information Systems

GLIMS Global Land Ice Measurement from Space 

GPS Global Positioning System

KU Kathmandu University 

NASA National Aeronautics and Space Administration

OLE DB Object Linking and Embedding Database 

PCS Projected Coordinate System

PM Post meridiem

SRTM Shuttle Radar Topography Mission

SQL Structured Query Language

TM Transverse Mercator 

TU Tribhuvan University

USAID United States Agency for International Development

USGS United States Geological Survey 

UTM Universal Transverse Mercator

WECS Water and Energy Commission Secretariat, Nepal

WGS World Geodetic System 

λ Longitude
Φ Latitude

h height

km kilometres

m metres

km2  square kilometres



ix

Part 1: Introduction to Geographic Information Systems (GIS)

About the Manual

This manual provides an introduction to Geographic Information Systems (GIS) and ArcGIS software. The ArcGIS 
platform and tools are explained so that they can be used for generating glacier database, analysis on glacier 
database and preparing glacier maps. The manual is divided into three parts – first part includes the introduction of 
GIS and descriptions of some of the fundamental terms used in GIS. The second part includes the hands-on exercise 
on ArcGIS to make you familiar on the software and the third part includes the detail exercise for generating different 
attribute of the glacier polygon with some analysis.

Read the manual carefully before doing hands-on exercises. Step by step processes are explained in bullet point 
format and short introductions to the data processing steps are in normal format.

Practice data for this manual are available at this link:
http://www.icimod.org/glacierdata/glacier_training_data.zip

Sudan Bikash Maharjan
Finu Shrestha
Samjwal Ratna Bajracharya
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A geographic information system (GIS) is a system designed to capture, store, manipulate, analyse, manage, 
and present all types of geographically referenced data (Figure 1.1). Although the term GIS is commonly used 
to describe software packages, a true GIS includes knowledgeable staff, hardware, data, and software. GIS 
technology can be used in almost any geography-related discipline, from landscape, architecture, natural resource 
management to transportation routing. The main purpose of a GIS is to turn geographic data into useful information 
that can provide answers to real life questions. 

Geographic – The key word is ‘geography’, which means that the data and information are associated with some 
location in space or referenced to locations on the earth.

Information – Tabular; attributes, or characteristics (data) can be used to symbolize and provide further insight into a 
given location.

Systems – a seamless operation linking the information to the geography – which requires hardware, networks, 
software, data, and operational procedures.  

1. Introduction to Geographic Information 
Systems (GIS)

Figure 1.1:  Conceptual diagram showing how people from across the world use GIS to acquire knowledge and 
integrated it as a decision tools for development
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1.1	 Functions of GIS
GIS uses the spatial and non-spatial attribute data to answer questions about the real world. Its spatial analysis 
function distinguishes it from other applications. Different authors or different GIS programmers may classify functions, 
manipulations, analyses and ways of data management in very different ways; in general the functions of GIS can 
be grouped into four processes: data acquisition and preprocessing; database management and retrieval; spatial 
modeling, measurement and analysis; and graphical output and visualization (Figure 1.2).

Data Acquisition and Preprocessing
Data used in GIS often come from different sources, are of many types, and are stored in different ways. A GIS 
provides tools and a method for integrating different data into a format to be compared and analysed. Data 
sources range from manual digitization and scanning of aerial photographs to paper maps and existing digital data 
sets. Remote-sensing satellite imagery and GPS are promising data input sources for GIS. It also provides a huge 
opportunity to interactively experiment with available data in order to obtain requisite map output or to confidently 
allow for any subsequent data analysis.

Database Management, Update and Retrieval
After data are collected and integrated, the GIS must provide facilities that can store and maintain data. Effective 
data management can be defined in many ways but should include all of the following aspects: data storage, data 
retrieval, data maintenance, data security and data integrity.

Spatial Modeling, Measurement and Analysis
Once data is acquired, assessed and stored, the collected information will be analysed and interpreted quantitatively 
and qualitatively. For example, satellite imagery can assist an agricultural scientist to project crop yield per hectare 
for a particular region. For the same region, the scientist also has the rainfall data for the past six months collected 
through weather station observations. The scientist also has a map of the soils in the region that shows the level of 
fertility and suitability for agriculture. These point data can be interpolated to get a thematic map showing isohyets, 
which are contour lines of rainfall. It can integrate various data sources and generate the final map which can help 
for decision makers. Some of the examples are – suitability map for settlement, agriculture and landslide susceptibility 
etc.

Presenting Results – Graphical Output and Visualization
One of the most exciting aspects of GIS technology is the variety of ways in which the information can be presented 
once it has been processed by GIS. Traditional methods of tabulating and graphing data can be supplemented by 
maps and three-dimensional images. Visual communication is one of the most fascinating aspects of GIS technology 
and is available in a diverse range of output options.

1.2	 Fundamental Data Types Used in GIS
Spatial data in a GIS database are stored in either vector or raster format.

Figure 1.2:  General functions of GIS
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Raster Data 
Rater data generalizes map features as cells or pixels in a grid matrix. The space is defined by a matrix of points 
or cells organized into rows and columns. In a raster data set, data values for a given parameter are stored in 
each cell – these values may represent an elevation in metres above sea level, a land use class, a plant biomass in 
grams per square metre, and so forth. The spatial resolution of the raster data set is determined by the size of the 
cell (Figure 1.3). For example, Landsat satellite imagery data are raster data that are corrected to have a cell size of 
approximately 30 metres on a side. However, spatial resolution can be much finer, or much coarser than 30 metres. 
In general, spatial resolution is a function of the data collection techniques used, and the desired outcomes.

The size of cells in a tessellated (highly symmetric, edge-to-edge tiling) data structure is selected on the basis of the 
data accuracy and the resolution needed by the user. There is no explicit coding of geographic coordinates required 
since that is implicit in the layout of the cells.

Advantages of Raster Data
zz The geographic location of each cell is implied by its position in the cell matrix. Accordingly, other than an origin 

point, e.g., bottom left corner, no geographic coordinates are stored.
zz Due to the nature of the data storage technique, data analysis is usually easy to program and quick to perform.
zz The inherent nature of raster maps, e.g., attribute maps, is ideally suited for mathematical modelling and 

quantitative analysis.
zz Discrete data (e.g., landcover) is accommodated equally well as continuous data (e.g., elevation data) and 

facilitates the integration of the two data types.

Disadvantages of Raster Data
zz The cell size determines the resolution at which the data is represented.
zz It is especially difficult to adequately represent linear features depending on the cell resolution. Thus, network 

linkages of linear features are difficult to establish.
zz Processing of associated attribute data may be cumbersome if large amounts of data exist. Raster maps inherently 

reflect only one attribute or characteristic for an area.
zz Since most input data is in vector form, data must undergo vector-to-raster conversion. Besides increased 

processing requirements, this may introduce data integrity concerns due to generalization and the choice of 
inappropriate cell size.

Vector Data
In vector data, objects are represented as points, lines or areas, whose positions are precisely specified. The 
position of each object is defined by a (series of) coordinate pairs. A point is described by a single X-Y coordinate 
pair and by its name or label. A line is described by a set of coordinate pairs and by its name and label. In reality, 

Figure 1.3:  Structure of raster data model showing the matrix structure into row and column of the cells, cell 
structure and values of cells

Source: ESRI
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a line is described by an infinite number of points (Figures 1.4 and 1.5). In practice, this is not a feasible way of 
storing a line. Therefore, a line is built up of straight line segments. An area, also called a Polygon, is described by 
a set of a coordinate pairs and by its name and label, with the difference that the coordinate pairs at the beginning 
and the end are the same.

Advantages of Vector Data
zz Data can be represented at its original resolution without generalization.
zz Graphic output is usually more aesthetically pleasing.
zz Since most data, e.g., hard copy maps are in vector form, no conversion is required.
zz Accurate geographic location of data is maintained.
zz Allows for efficient encoding of topology, and as a result more efficient operations that require topological 

information, e.g., proximity, network analysis.

Disadvantages of Vector Data
zz The location of each vertex needs to be stored explicitly.
zz Algorithms for manipulative and analysis functions are complex and may be processing intensive.
zz Continuous data, such as elevation data, is not effectively represented in vector form. 
zz Spatial analysis and filtering within polygons is impossible.

Figure 1.4:  Structures of vector data model showing the notation of points and representation of points, lines 
and polygons

Figure 1.5:  Representation of vector and raster data

Source: Online

Source: Online
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Attribute Data
Attribute data is information appended in tabular format to spatial features (Vector or Raster data). It provides the 
characteristics of spatial data. Attribute data can be stored as one of the five different field types in a table or 
database – character, integer, floating, date and binary large object (BLOB).

Character Data
The character property (or string) is for text-based values such as the name of a street or descriptive values such as 
the condition of a street. Character attribute data is stored as a series of alphanumeric symbols.

Aside from descriptors, character fields can contain other attribute values such as categories and ranks. For example, 
a character field may contain the categories for a street: avenue, boulevard, lane, or highway. A character field 
could also contain the rank, which is a relative ordering of features. For example, a ranking of the traffic load of the 
street with “1” being the street with the highest traffic.

Character data can be sorted in ascending (A to Z) and descending (Z to A) order. Since numbers are considered 
text in this field, those numbers will be sorted alphabetically, which means that a number sequence of 1, 2, 9, 
11, 13, 22 would be sorted in ascending order as 1, 11, 13, 2, 22, 9. Because character data is not numeric, 
calculations (sum, average, median, etc.) can’t be performed on this type of field, even if the value stored in the 
field are numbers (to do that, the field type would need to be converted to a numeric field). Character fields can be 
summarized to produce counts (e.g., the number of features that have been categorized as “avenue”).

Numeric Data
Integer and floating are numerical values (see: the difference between floating and integer values). Within the 
integer type, it is a further division between short and long integer values. As would be expected, short integers 
store numeric values without fractional values for a shorter range than long integers. Floating point attribute values 
store numeric values with fractional values. Fractional values can be a float (single-precision floating-point number) or 
a double (double-precision floating-point numbers). These floating point values are for numeric values with decimal 
points (i.e., numbers to the right of the decimal point as opposed to whole values).

While choosing between a short or long integer or between a float or double, it is advisable to choose the data 
type that takes up the least storage space. This will not only minimize the amount of storage required but will also 
improve performance. For instance, if integers between -32,768 and 32,767 need to be stored, it is better to 
specify the short integer data type because it would take up only 2 bytes of storage, whereas the long integer data 
type takes up 4 bytes of storage. If fractional numbers between -3.4E38 and 1.2E38 need to be stored, it is good 
to specify the float data type because it takes 4 bytes of storage, whereas the double data type takes up 8 bytes of 
storage. The table lists data types, their ranges, and storage requirements. The ranges listed are for file and personal 
geodatabases (Table 1).

For a numeric field, the precision (i.e., the maximum length of the field) and scale (the maximum number of decimal 
places) need to be defined. For example, a float is specified with a precision of 4 and a scale of 2; the field could 
be 12.34.

Table 1:  Details of various numeric data types

Data type Storable range Size (Bytes) Applications

Short integer -32,768 to 32,767 2 Numeric values without fractional values within 
specific range; coded values

Long integer -2,147,483,648 to 
2,147,483,647

4 Numeric values without fractional values within 
specific range

Float (single-precision floating-point 
number)

approximately -3.4E38 
to 1.2E38

4 Numeric values with fractional values within specific 
range

Double (double-precision floating-
point number)

approximately 
-2.2E308 to 1.8E308

8 Numeric values with fractional values within specific 
range
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Numeric values will be sorted sequentially either in ascending (1 to 10) or descending (10 to 1) order. Numerical 
value fields can have operations performed such as calculating the sum or average value. Numerical field values 
can be a count (e.g., the total number of students at a school) or a ratio (e.g., the percentage of students that are 
girls at a school).

Date
The date data type can store dates, times, or dates and times. The default format in which the information is 
presented is ‘mm/dd/yyyy hh:mm:ss’ and a specification of AM or PM. When you enter date fields in the table 
through ArcGIS, they are converted to this format.

BLOBs
BLOB stands for binary large object and this attribute type is used for storing information such as images, 
multimedia, or bits of code in a field. A BLOB is data stored as a long sequence of binary numbers. ArcGIS stores 
annotation and dimensions as BLOBs, and items such as images, multimedia, or bits of code. YoA custom loader or 
viewer or a third-party application is needed to load items into a BLOB field or view the contents of a BLOB field.

1.3	 Coordinate Systems
Coordinate systems enable geographic datasets to use common locations for integration. A coordinate system is a 
reference system used to represent the locations of geographic features, imagery, and observations such as GPS 
locations within a common geographic framework. Each coordinate system is defined by:

zz Its measurement framework, which is either geographic (in which spherical coordinates are measured from 
the earth’s centre) or planimetric (in which the earth’s coordinates are projected onto a two-dimensional planar 
surface).

zz Unit of measurement (typically feet or metres for projected coordinate systems or decimal degrees for latitude-
longitude).

zz The definition of the map projection for projected coordinate systems.
zz Other measurement system properties such as a spheroid of reference, a datum, and projection parameters like 

one or more standard parallels, a central meridian, and possible shifts in the x- and y-directions.

There are two common types of coordinate systems used in GIS:

zz A global or spherical coordinate system such as latitude-longitude. These are often referred to as geographic 
coordinate systems.

zz A projected coordinate system based on a map projection such as transverse Mercator, Albers equal area, or 
Robinson, all of which (along with numerous other map projection models) provide various mechanisms to project 
maps of the earth’s spherical surface onto a two-dimensional Cartesian coordinate plane. Projected coordinate 
systems are sometimes referred to as map projections.

Coordinate systems (either geographic or projected) provide a framework for defining real-world locations. In 
ArcGIS, the coordinate system is used as the method to automatically integrate the geographic locations from 
different datasets into a common coordinate framework for display and analysis.

Geographic Coordinate System (GCS)
A geographic coordinate system (GCS) uses a three-dimensional spherical surface to define locations on the earth. A 
GCS is often incorrectly called a datum, but a datum is only one part of a GCS. A GCS includes an angular unit of 
measure, a prime meridian, and a datum (based on a spheroid).

A point is referenced by its longitude and latitude values. Longitude and latitude are angles measured from the 
earth’s centre to a point on the earth’s surface. The angles are often measured in degrees (or in grads). The following 
illustration shows the world as a globe with longitude and latitude values (Figure 1.6).
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Figure 1.6:  Representation of the earth showing 
longitude and latitude of a point in globe

In the spherical system, horizontal lines, or east-west lines, are lines of equal latitude, or parallels. Vertical lines, or 
north-south lines, are lines of equal longitude, or meridians. These lines encompass the globe and form a gridded 
network called a graticule.

The line of latitude midway between the poles is called the equator. It defines the line of zero latitude. The line of 
zero longitude is called the prime meridian (Figure 1.7). For most geographic coordinate systems, the prime meridian 
is the longitude that passes through Greenwich, England. Other countries use longitude lines that pass through Bern, 
Bogota, and Paris as prime meridians. The origin of the graticule (0,0) is defined by where the equator and prime 
meridian intersect. The globe is then divided into four geographical quadrants that are based on compass bearings 
from the origin. North and south are above and below the equator, and west and east are to the left and right of the 
prime meridian.

Latitude and longitude values are traditionally measured either in decimal degrees or in degrees, minutes, and 
seconds (DMS). Latitude values are measured relative to the equator and range from -90° at the South Pole to +90° 
at the North Pole. Longitude values are measured relative to the prime meridian. They range from -180° when 
travelling west to 180° when travelling east.

The shape and size of a geographic coordinate 
system’s surface is defined by a sphere or spheroid. 
Although the earth is best represented by a spheroid 
or ellipsoid (shapes that are generated by revolving an 
ellipsis around its minor axis), it is sometimes treated as 
a sphere to make mathematical calculations easier. The 
earth shape is represented by an ellipsoid of rotation (or 
called a spheroid) with the length of the major semi-axis 
(a) and minor semi-axis (b), as shown in the figure below 
(Figure 1.8).

Projected Coordinate System (PCS)
A projected coordinate system is defined on a 
flat, two-dimensional surface. Unlike a geographic 
coordinate system, a projected coordinate system has 
constant lengths, angles, and areas across the two 

Figure 1.7:  Representation of globe showing parallels 
and meridians lines

Figure 1.8:  Representation of the globe in ellipsoid 
showing major (a) and minor axis (b)

Source: ESRI Source: ESRI

Source: ESRI
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dimensions. A projected coordinate system is always based on a geographic coordinate system that is based on 
a sphere or spheroid.

In a projected coordinate system, locations are identified by x, y coordinates on a grid, with the origin at the centre 
of the grid (Figure 1.9). Each position has two values that reference it to that central location. One specifies its 
horizontal position and the other its vertical position. The two values are called the x-coordinate and y-coordinate. 
Using this notation, the coordinates at the origin are x = 0 and y = 0.

On a gridded network of equally spaced horizontal and vertical lines, the horizontal line in the centre is called the 
x-axis and the central vertical line is called the y-axis. Units are consistent and equally spaced across the full range 
of x and y. Horizontal lines above the origin and vertical lines to the right of the origin have positive values; those 
below or to the left have negative values. The four quadrants represent the four possible combinations of positive and 
negative X and Y coordinates.

When working with data in a geographic coordinate system, it is sometimes useful to equate the longitude values 
with the X axis and the latitude values with the Y axis.

Figure 1.9:  Geographic coordinate system (locations are expressed as longitude and latitude) on a globe and 
the projected coordinate system (locations are expressed as x, y coordinates on a map)
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1.4	 Map Projection System
A map projection is the manner in which the spherical surface of the Earth is represented on a flat (two-dimensional) 
surface. It is a process of transferring location on the curved surface of the earth with the geodetic coordinate (MO) 
to planer map coordinates (XY). This can be accomplished by direct geometric projection or by a mathematically 
derived transformation. There are many kinds of projections, but all involve transfer of the distinctive global patterns 
of parallels of latitude and meridians of longitude onto an easily flattened surface, or developable surface.

The three most common developable surfaces are the cylinder, cone, and plane (Figure 1.10). A plane is already 
flat, while a cylinder or cone may be cut and laid out flat, without stretching. Thus, map projections may be 
classified into three general families: cylindrical, conical, and azimuthal or planar.

Properties of Map Projection
Regardless of what type of projection is used, some error or distortion is inevitable while transforming a spherical 
surface into a flat surface. Ideally, a distortion-free map has four valuable properties:

zz Conformality
zz Equivalence
zz Equidistance
zz True direction

Each of these properties is explained below. No map projection can be true in all of these properties. Therefore, 
each projection is devised to be true in selected properties, or most often, a compromise among selected properties. 
Projections that compromise in this manner are known as compromise projections.

Figure 1.10:  Illustration of different types of map projection system
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Conformality is the characteristic of true shape, wherein a projection preserves the shape of any small geographical 
area. This is accomplished by exact transformation of angles around points. One necessary condition is the 
perpendicular intersection of grid lines as on the globe. The property of conformality is important in maps which are 
used for analysing, guiding, or recording motion, as in navigation. A conformal map or projection is one that has 
the property of true shape.

Equivalence is the characteristic of equal area, meaning that areas on one portion of a map are in scale with areas 
in any other portion. Preservation of equivalence involves inexact transformation of angles around points and thus, is 
mutually exclusive with conformality except along one or two selected lines. The property of equivalence is important 
in maps that are used for comparing density and distribution data, as in populations.

Equidistance is the characteristic of true distance measurement. The scale of distance is constant over the entire map. 
This property can be fulfilled on any given map from one, or at most two, points in any direction or along certain 
lines. Equidistance is important in maps that are used for analysing measurements (i.e., road distances). Typically, 
reference lines such as the equator or a meridian are chosen to have equidistance and are termed standard parallels 
or standard meridians. 

True direction is characterized by a direction line between two points that crosses reference lines (e.g., meridians) at 
a constant angle or azimuth. An azimuth is an angle measured clockwise from a meridian, going north to east. The 
line of constant or equal direction is termed a rhumb line.

The property of constant direction makes it comparatively easy to chart a navigational course. However, on a 
spherical surface, the shortest surface distance between two points is not a rhumb line, but a great circle, being an 
arc of a circle whose centre is the centre of the Earth. Along a great circle, azimuths constantly change (unless the 
great circle is the equator or a meridian). Thus, a more desirable property than true direction may be where great 
circles are represented by straight lines. This characteristic is most important in aviation. Note that all meridians 
are great circles, but the only parallel that is a great circle is the equator. flat, while a cylinder or cone may be cut 
and laid out flat, without stretching. Thus, map projections may be classified into three general families: cylindrical, 
conical, and azimuthal or planar.

Types of Projections
Although a great number of projections have been devised, the majority of them are geometric or mathematical 
variants of the basic direct geometric projection families described below. Choice of the projection to be used 
depends upon the true property or combination of properties desired for effective cartographic analysis.

Azimuthal or Planer or Perspective Projections
This projection is accomplished by drawing lines onto the plane tangent to the globe. This is conceptually equivalent 
to tracing a shadow of a figure cast by a light source. A tangent plane intersects the globe surface at only one 
point and is perpendicular to a line passing through the centre of the sphere. Thus these projections are symmetrical 
around a chosen centre or central meridian. So the characteristic outline of the world map would be circular. If the 
pole is the centre point, the meridians are straight lines, spaced at their true angles intersecting at the centre point. 
Parallels are represented as concentric circles.

This projections may be centred (Figure 1.11):

zz On the poles (polar aspect);
zz At a point on the equator (equatorial aspect);
zz At any other orientation (oblique aspect).
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The origin of the projection lines – that is, the perspective point – may also assume to be at various positions  
(Figure 1.12):

zz The centre of the Earth (gnomonic);
zz An infinite distance away (orthographic);
zz On the Earth’s surface, opposite the projection plane (stereographic).

Conical Projection
This projection is accomplished by intersecting, or touching, a cone with the global surface and mathematically 
projecting lines into the developable area. It is wrapped like a cone around the globe and after unrolling the outline 
of the world would be fan shaped. The meridians are represented as straight lines and parallels as concentric 
circles. Only the parallels where the 
cone touches the global surface have 
the same lengths as on earth  
(Figure 1.13).

Conical projections are classified 
by aspect as well as cone size. The 
aspect wise conical projections are 
normal, equatorial or transverse and 
oblique, and based on cone size 
the projection is inside, tangent and 
secant.

Figure 1.12:  Types of Azimuthal projection based on the origin of the projection lines

Figure 1.13:  Illustration of a conical projection system

Figure 1.11:  Aspect wise classification of various types of azimuthal projections - on the poles (polar aspect); 
at a point on the equator (equatorial aspect) and at any other orientation (oblique aspect)

Source: ESRI

Source: ESRI

Source: ESRI
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A tangent cone intersects the globe to form a circle. Along this line of intersection, the map is error-free and 
possesses equidistance. Usually this line is a parallel, termed ‘the standard parallel’ (Figure 1.14).

A secant cone intersects the global surface forming two circles that possess equidistance. In this case the cone slices 
underneath the global surface, between the standard parallels (Figure 1.15). Note that the use of the word secant, 
in this instance, is only conceptual and not geometrically accurate.

One of the popular conical projections is Lambert’s conformal conic in which the angle is conformal with an equal 
angle and distance in an area of 300 km in east-west and 500 km in north-south.

Cylindrical Projection
A projection to a plane that is 
wrapped around the globe in the 
form of a cylinder. The surface 
is mathematically projected onto 
the cylinder, which is then cut 
and unrolled. After unrolling, 
the outline of the globe would 
be rectangular in shape; the 
meridians are parallel straight 
lines that are crossed at right 
angles by parallel straight lines of 
latitude (Figure 1.16). 

Figure 1.14:  Illustration of a tangent cone intersecting the globe

Figure 1.15:  Illustration of a secant cone intersecting the globe showing two parallels 

Figure 1.16:  Illustration of a cylindrical projection system

Source: ESRI

Source: ESRI
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Like the conical projection system, the cylindrical projection is classified by aspect as well as cylinder size. The 
aspect wise cylindrical projections are normal, equatorial or transverse and oblique (Figure 1.17), and based on 
cylinder size it is inside, tangent and secant.

A tangent cylinder intersects the global surface on only one line to form a circle, as with a tangent cone. This central 
line of the projection is commonly the equator and possesses equidistance. If the cylinder is rotated 90 degrees from 
the vertical (i.e., the long axis becomes horizontal), then the aspect becomes transverse, wherein the central line of 
the projection becomes a chosen standard meridian as opposed to a standard parallel (Figure 1.18).

A secant cylinder, only slightly 
smaller in diameter than the 
globe, has two lines possessing 
equidistance (Figure 1.19).

One of the most popular cylindrical 
projections is the Universal 
Transverse Mercator (UTM) with a 
transverse axis, secant cylinder and 
conformality (equal angle).

Figure 1.18:  Illustration of tangent cylindrical projection showing single parallel line representation on map

Figure 1.19:  Illustration of secant cylindrical projection showing two 
parallel lines intersecting on the globe and representation it in planer map

Figure 1.17:  Types of cylindrical projections based on the aspect of cylinder

Source: ESRI

Source: https://en.wikipedia.org/wiki/Mercator_projection

Source: https://en.wikipedia.org/wiki/Mercator_projection
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Map Projection Parameters
Each map projection has a set of parameters that must be defined. The parameters specify the origin and customize 
a projection for the area of interest. Angular parameters use the geographic coordinate system units, while linear 
parameters use the projected coordinate system units.

Linear Parameters
False easting is a linear value applied to the origin of the x-coordinates. For instance, if the origin of projection (in 
latitude/longitude) is in the centre of the map, all areas west of the origin would be negative when false easting of 
zero is assigned. To make the coordinate positive for the entire map, set the false easting to a positive number.

False northing is a linear value applied to the origin of the Y-coordinates. For instance, if the origin of the projection 
(in latitude/longitude) is in the centre of the map, all area south of the origin would be negative unless a positive 
false northing is assigned.

False easting and northing values are usually applied to ensure that all x- and y-values are positive. You can also use 
the false easting and northing parameters to reduce the range of the x- or y-coordinate values. For example, if you 
know all y-values are greater than 5,000,000 metres, you could apply a false northing of -5,000,000.

Angular Parameters
zz Azimuth defines the centre line of a projection. The rotation angle measures east from north. This is used with the 

azimuth cases of the Hotine Oblique Mercator, rectified skew orthomorphic, and Local projections.
zz Central meridian defines the origin of the x-coordinates. The single line of longitude that is truly vertical on the 

map. It is usually in the middle of the map.
zz Longitude of origin defines the origin of the x-coordinates. The central meridian and longitude of origin 

parameters are synonymous.
zz Central parallel defines the origin of the y-coordinates.
zz Latitude of origin defines the origin of the y-coordinates. This parameter may not be located at the centre of the 

projection. In particular, conic projections use this parameter to set the origin of the y-coordinates below the area 
of interest. In that instance, you don’t need to set a false northing parameter to ensure that all y-coordinates are 
positive.

zz Longitude of centre is used with the Hotine Oblique Mercator centre (both two-point and azimuth) cases to define 
the origin of the x-coordinates. This is usually synonymous with the longitude of origin and central meridian 
parameters.

zz Latitude of centre is used with the Hotine Oblique Mercator centre (both two-point and azimuth) cases to define 
the origin of the y-coordinates. It is almost always the centre of the projection.

Standard parallel 1 and standard parallel 2 are used with conic projections to define the latitude lines where the 
scale is 1.0. When defining a Lambert conformal conic projection with one standard parallel, the first standard 
parallel defines the origin of the y-coordinates. 

Unitless Parameters
Scale factor is a unitless value applied to the centre point or line of a map projection. The scale factor is usually 
slightly less than one. The Universal Transverse Mercator (UTM) coordinate system, which uses the Transverse 
Mercator projection, has a scale factor of 0.9996. Rather than 1.0, the scale along the central meridian of the 
projection is 0.9996. This creates two almost parallel lines approximately 180 kilometres, or about 1°, away where 
the scale is 1.0. The scale factor reduces the overall distortion of the projection in the area of interest.
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2.	Introduction to ArcGIS and  
Hands-on Exercises

ArcGIS comprises a set of integrated applications/software programs. It is used to create, display and analyse 
geospatial data and is developed by the Environmental Systems Research Institute (ESRI) of Redlands, California. It 
has three components: ArcCatalog, ArcMap and ArcToolbox. 

zz ArcCatalog: It is used for browsing maps and spatial data, exploring spatial data, viewing and creating 
metadata, and managing spatial data. It also allows users to search, preview and add data to ArcMap, use 
Arctoolbox for processing the data, and set up address locator services (geocoding).

zz ArcMap: It is the main mapping application used for visualizing spatial data, performing spatial analysis, and 
creating maps to show the results of your work.

zz ArcToolbox: It is an interface for accessing the data conversion and analysis function that comes with ArcGIS. 
Although it cannot be directly accessible from the Start menu as ArcCatalog and ArcMap, it is easily accessed 
and used within ArcMap and ArcCatalog. It contains tools for geoprocessing, data conversion, coordinate 
systems, projections and more.

ArcGIS comes in three software product levels: ArcView, ArcEditor, and ArcInfo. These products share a common 
architecture but provide increasing level of functionality. 

zz ArcView: it provides the base mapping and analysis tools. 
zz ArcEditor: it provides all ArcView capability and includes additional processing and advanced editing. 
zz ArcInfo: it provides all ArcEditor capability plus advanced analysis and processing. 

While these levels should be carefully considered while purchasing software, it is also important to be aware of the 
limitations of the level you are using.

The common ArcGIS files are:

Geodatabase – The personal geodatabase, or geographic database, file is called the “modern container for GIS 
data” and is specific to ArcGIS. Geodatabases define, manage, process and store all the types of data that can be 
used in ArcGIS (i.e., feature, rasters, relationships, measurements, attributes, etc.) inside either a Microsoft Access 
database (.mdb) or a full relational database (SQL Server, Oracle, Informix or DB2). 

Shapefiles – ArcGIS shapefile format is a widely adopted standard and comprises three or more associated files. It 
is a simple, non-topological format for storing geographic features with its attribute information. Geographic features 
in a shapefile can be represented by points, lines or polygons. Be careful while copying this data to a disk. You 
must get all of the files associated with a single layer. They will have a variety of file extensions: .shp, .shx, .dbf 
and sometimes others. If you are copying shapefiles, we recommend that you use the ‘File’ > ‘Data’ > ‘Export Data’ 
function in ArcMap or through ArcCatalog. This will automatically copy all files associated with a layer. Also, be 
aware that some of these files may be very large in size. 

Layer – According to ESRI, the layer file (.lyr) stores symbology, symbology classifications, labelling properties, scale 
dependency, and definition. If you save something in this format it means that, unlike in shapefiles, colours and other 
characteristics are saved and will appear the same every time you open it. 

Coverages – “A coverage stores a set of thematically associated data considered to be a unit. It usually represents 
a single layer, such as soils, streams, roads, or land use. In a coverage, features are stored as both primary features 
(points, arcs, polygons) and secondary features (tics, links, annotation).” Source: ESRI Data Dictionary. 

CAD (computer-aided design) – “A computer-based system for the design, drafting, and display of graphical 
information.” Although most commonly used to support engineering, planning, and illustrating activities, these files 
can be used in a GIS. Source: ESRI Data Dictionary. 

Image formats – ArcGIS accepts and uses a variety of image files (.tiff, .jpg, .jp2, .png, etc.).

Text files (with x, y coordinates)
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2.1	 ArcCatalog
ArcCatalog is an application for managing the spatial data holdings, database designs, and for recording and 
viewing metadata. It lets you find, preview, document, and organize geographic data and create a sophisticated 
geodatabase to store data. It provides a framework for organizing large and diverse repositories of GIS data.

It is roughly equivalent to the Windows Explorer interface, in that it provides an interface from which to browse and 
manage geographic data and databases. Because Windows Explorer does not properly recognize all of the various 
components of geographic datasets, it is always best to use ArcCatalog to manage your data.

Exercise in ArcCatalog
In this exercise, you will explore the overview of the ArcCalalog, connect the data folder, visualize the various types 
of data, manage the folders and files, view metadata about the data and create new GIS shapefiles.

zz To start the ArcCatalog – go to Windows Start menu > All Programs and select ArcCatalog from ArcGiS menu 
lists. Then the ArcCatalog window will open.

In the ArcCatalog window, the panel on the left side is the ‘Catalog Tree’ where you can browse folders on your 
system for geographic data. Note that only folders and files compatible with ArcGIS will displayed in the Catalog 
tree and the View Windows on the right.

If your data folder is not shown or if 
you want to add quick access to your 
data folder, you need to connect your 
data folder.

zz To connect your data folder, go to 
file menu on top of the ArcCatalog 
> click ‘Connect to Folder’ in the file 
menu list.
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The ‘Connect to Folder’ menu will open.

zz Browse your training data folder in the folder tree menu and select TrainingData folder from the list > click OK to 
connect the folder.

zz Now you can view your TrainingData folder connection list in the Folder Connection Tree list in the Catalog Tree.

zz Expand the C:\TrainingData in the Folder Connections in ArcCatalog Tree and click on GIS folder to display its 
contents in the Contents tab of the View window on the right side.

You will notice several files in this 
folder, not all of which are actually 
geographic data, but are in some 
way supported in ArcGIS. 

zz Click on the Bhutan_bnd.shp file 
in the list.

zz Click on the Preview tab in the 
View window on the right of the 
ArcCatalog window.

Now you can preview the 
geographic data (Bhutan boundary) 
in ArcCatalog.

20



21

Part 2: Introduction to ArcGIS and Hands-on Exercises

20

zz At the bottom of the Preview screen, change the Preview: Drop-down to Table, and examine the Table for this 
dataset.

zz Change to the Description tab, at the top of the ArcCatalog view window to see the additional information/
metadata about the data.

This section shows the metadata about the data, which is defined as ‘data about data. This information is important, 
especially in a geospatial context, because it gives information about the source, author, creation and geographic 
referencing. Here in the Description tab, it provides a description of the files, spatial information, and a list of all the 
attributes associated with the files, and allows you to edit, print and import the information on the data.

Create New Shapefile – ArcCatalog
A shapefile can be represented by different geographic features – points, polylines and polygons. In this exercise, 
you can create any one type of shapefile, as this exercise is only aimed at showing the process of creating a new 
shapefile. While creating a shapefile you can define the type of features as routes (m-values) or three-dimesional 
(z-values), and these properties cannot be modified after the shapefile has been created. You also need to define the 
coordinate system of the shapefile.
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zz Expand the C:\TrainingData in the Folder Connections in the ArcCatalog Tree and click on the GIS folder to 
display its contents in the Contents tab of the View window on the right side.

zz To create a new shapefile, right click on the Folder in ‘Catalog Tree’ or in ‘Contents View’ window of the folder 
where you want to create the new shapefile or go to ‘File Menu’ at the top of the ArcCatalog window.

zz Go to ‘New’ and select the shapefile from the list. 

The ‘Create New Shapefile’ window will open.
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zz Type the name of the new shapefile in the Name textbox
zz Select the type of the shapefile – point, polyline or polygon – from the dropdown Feature Type menu.
zz Define the Spatial reference of the new shapefile – click the Edit button – the Spatial Reference Properties window 

will open.

zz Expand the Geographic Coordinate Systems ‘World’ and select ‘WGS 1984’ from the list as Spatial Reference 
for the shapefile and click OK.

zz Click OK.

Now you can see the new shapefile in the Contents list. Note that the icon of the new shapefile will be different for 
different feature types; for Point, the icon looks like ; for Polyline ; and for Polygon . At this point there will 
not be any feature data in the shapefile; to add the data in the shapefile you need to open it in ArcMap and add 
the data in it by enabling the editing mode.
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2.2	 ArcMap
ArcMap is the main component of ArcGIS suite of geospatial processing programs, and is used to perform a wide 
range of common GIS tasks as well as specialized, user-specific tasks. It is used primarily to view, edit, create, 
and analyse geospatial data. It allows users to explore data within a data set, symbolize features accordingly, and 
create map layouts. The most common workflows that can be performed in ArcMap are:

zz Work with maps
zz Print maps
zz Compile and edit GIS datasets
zz Use geo-processing to automate work and perform analysis
zz Organize and manage geodatabases and ArcGIS documents
zz Publish map documents as map services using ArcGIS Server
zz Share maps, layers, geo-processing models, and geodatabases with other users
zz Document geographic information
zz Customize the user experiences

Getting Started with ArcMap
To start the ArcMap, click the Windows button and go to the programs list, then select the ArcMap 

icon  from the list.

Upon opening ArcMap you may see the following startup window:

 

This is a new feature in version 10.x of 
ArcGIS software that allows you to make 
a shortcut to your most-used data location. 
Since we’re just beginning, we are going to 
skip this option and simply use the default. 
Click Cancel.

Now, a new, blank ArcMap window will 
open.
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The ArcMap contains the following features:

zz Menu bar, toolbars and status bar
zz Map or Project View.
zz Table of contents.

Menu Bar
The menu bar is in the top row of the main window. It contains File, Edit, View, Bookmarks, Insert, Selection, 
Geoprocessing, Customize, Windows and Help options. Each option in the menu bar contains a drop-down menu.

	

Toolbar
Toolbars contain buttons or list boxes to help you view or analyse data. To check and modify the displayed toolbars, 
select ‘View’ > ‘Toolbars’ in the main menu bar. Alternatively, you can go to the Toolbars tab of the Customize dialog 
box. 

Toolbars may be docked at the edges of the main window. Also, they may be undocked as floating toolbars. 
Holding Ctrl while dragging deactivates the magnetic snapping, allowing you to place the toolbars anywhere on 
your screen. Right-clicking anywhere inside the menu bar and toolbar area allows you to access a context menu 
which provides a selection of the View menu options.

Any changes made to the interface will be kept and applied every time you use ArcMap. Please note that some 
toolbars are dependent upon the license level. Some toolbars and extensions will be visible, but the user will not be 
able to access the functionality if they do not possess the required license. 

Standard Toolbar
It appears at the top of the ArcMap and is used for creating a new project, opening an existing project or map, 
saving maps, adding data layers, redo and undo processes, opening Arctoolbox- ArcCatalog- Python command 
window and model builder, etc.

     

Title Bar
Menu Bar

Tool Bar

Map or Project

Status Bar

Table of Contents
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Tools Toolbar
It is used for map navigation and query within the active data frame. It allows you to adjust zooming level, restore 
the map extent, go forward or backward to previous view extent, select and deselect features on the map, view 
information on map features, set a hyperlink, carry out measurements on the map, and search the features and 
location points on the map. All these functions only apply in active map view.

	

Effects Toolbar
This toolbar is used for interactive display of layer in map view. It allows users to adjust contrast, brightness, 
transparency level of the layers in the active map view, as well as to swipe the selected layers.

Layout Toolbar
This toolbar consists of navigation tools used for navigating around the page of the map layouts. The tools will only 
be activated when you open the map layout view in the map view.

	    	       

Draw Toolbar
This toolbar is used to add and edit graphical elements in the map layout page.

Editor Toolbar
It consists of various tools for editing the data in map view. This tool is used to enable/start, save and stop the 
editing mode in the map view. To add, modify and remove features/data in your data layers, you need to enable 
the ‘start editing’ mode in this toolbar and you can use various editing commands in this toolbar. You can also use 
additional editing toolbars available in ArcMap such as Advance Editing, COGO, Geometric Network Editing, 
Topology, Representation, Routing, etc.

Georeferencing Toolbar
Raster data commonly obtained by scanning maps or collecting aerial photographs does not normally contain 
spatial reference information. Sometimes the location information delivered from satellite imagery is inadequate 
and data does not align properly with other datasets. Thus, to use these datasets in conjunction with other datasets, 
you need to align or reference them to a map coordinate system. For that purpose we use this toolbar to align or 
georeference the data into a map coordinate system. To georeference the data you need to define its location using 
map coordinates and assign the coordinate system of the data frame. This toolbar allows you to georeference raster 
datasets, raster layers, images and raster products.
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Adding Data to ArcMap
In ArcMap you can add data layers in two ways.

zz Click on the ArcCatalog tab  icon in the Standard toolbar. You will see the catalog tree. Navigate to the data 
(c:\TrainingData\GIS) and drag and drop the data into the Table of Contents under Layers.

	 Or 

zz Click the add button   in the Standard toolbar or go to File menu in the menu bar and select ‘Add Data’ 
from the ‘Add Data’ list; or you can open the ArcCatalog from the standard menu bar - Then explore the location 
of the data and drag & drop the layer you want to add.

zz The ‘Add Data’ sub-window will open. 
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zz To connect the data folder, click on ‘Connect To Folder’  
 icon in the ‘Add Data’ sub-window and select the 

data folder ‘C:/TrainingData’ from the folder list, then click 
the ‘OK’ button in the ‘Connect To Folder’ window. The 
‘TrainingData’ folder is added to the list for quick access.

zz Now open the GIS Data folder from the list. Select the 
‘Bhutan_bnd.shp’ data and click the ‘Add’ button to add 
the data.

zz Again, explore the location of the data ‘C:\trainingData’ 
and select the data such as ‘Basin.shp’, ‘District.shp’, ‘Sub-
basin.shp’ and so on.

Now you can see the list of the added layers in the Table of 
Contents. Each layer has a check mark in the box to its left that 
indicates that they are turned on and displayed. Layers that 
are not checked are no longer visible in ‘Map View’.

The color of the layers and their order may be different on each user screen. Each of these layers contains geometric 
objects that represent some real world entity. Points are used in the layer to represent the location of cities. Lines are 
used to represent the roads, and polygons are used to represent the country boundary, district boundary, and basin 
boundaries. 

Notice how most of the button and toolbar functions are available now. Also notice the scale display next to the Add 
Data button . This display tells you what the scale value of the current view is. If it displays the 
value ‘1: 2,423,455’ it means each unit on the map is equal to 2,423,455 units in the real world. As you zoom 
in and out of the map, the scale will change dynamically. Scale is an important concept in computer mapping. 
The scale of the map often determines the amount of information that can be shown without the map becoming too 
crowded.

Also notice the position display at the bottom right (Status bar) of the screen. As you move the cursor around the 
view, these units change dynamically according to your cursor’s position. Your map units will likely be in decimal 



29

Part 2: Introduction to ArcGIS and Hands-on Exercises

28

degrees . The first number in the display is longitude value and second number is 
latitude value.

Using the main tools 
The toolbar contains buttons for zooming, panning, selection, identifying the features, Hyperlink, finding contents, 
input xy point and measuring on Map view. Some of the most useful ones are illustrated here.

Zoom In/Out
Zoom In   – zooms the view window in to a user-defined area. To use: 

zz Select the Zoom In tool with the left mouse button. Notice the cursor changes to a magnifying glass with a + sign 
icon. 

zz Go to a corner of the area you would like to zoom in on and click the left mouse button. While holding down the 
mouse button, move the cursor to the opposite corner that defines the area you want to magnify. 

zz Release the mouse and the view window should zoom in to your defined area and redraw. 

Zoom Out   – zooms the view window out from the point clicked. To use: 

zz Select the Zoom Out tool with the left mouse button. Notice the cursor changes to a magnifying glass with a ‘-’ 
sign icon. 

zz Using the left mouse button click on the area of the map you want to zoom out of. The view window should zoom 
out, centering on the area that you clicked on. 

Pan   – moves all the view layer layers in the direction you move your mouse. It is a useful tool for viewing data 
that is larger than the view window, and you do not want to change your scale or loose detail by zooming out. To 
use: 

zz Select the Pan tool with the left mouse button. Notice the cursor changes to a hand. 
zz Click a spot on the view with the left mouse button, and while holding down the button move the mouse away 

from the direction you want to move the view and release the button. The view should move and redraw the view 
in the new location once the mouse button is released. 

Full Extent   – zooms the view window to the full extent of all layers shown in the view. This is very handy when 
you want to get back to the way things looked when you first added the layer.

Zoom to Previous Extent   – zooms the view window back to the previous view window extent. 

Practice using the zooming and panning tools to view data. You 
may also zoom in and out by using the wheel on your mouse 
and holding ‘Ctrl’ on your keyboard. You can always return to 
the initial view by pressing the ‘Full Extent’  button; so don’t 
be afraid to move around! 

Identify Objects 
The identify tool helps us to identify the objects of the layer. It is 
located on the Tools toolbar and it has the icon with the letter 
‘i’ in a blue circle . This tool will display the attributes of a 
particular layer object. These attributes are actually located in a 
table of the layer. To use the identify tool:

zz Click on the identify tool  using the left mouse button. Your 
cursor changes to a selection with the ‘  ‘ icon.

When you click on a feature in the map, the ‘Identify’ window 
will open and you can choose what layers you would like to 
identify or see what you have identified. 
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Selecting Features 
Selecting features allows you to identify or work with a subset of features. You’ll most likely work with selected 
features when you are querying, exploring, analysing, or editing data. Applying a selection lets you specify the 
features you want to calculate statistics for, view attributes for, or edit or define the set of features that comprise a 
map layer.

There are several ways you can select features. You can select features with your mouse pointer by clicking on 
them one at a time or by dragging a box around them on the map. There are two main ways to select features 
interactively on the map:

zz Use the ‘Select Features’ tool   on the Tools toolbar. 
zz Select their records in the attribute table or Map window with your mouse pointer.

Setting Map Units, Display Units and Map Projection
One of the most important things that you should do after adding data is to set the map and display units. It is also 
a good idea to set the projection (if desired) at this stage as well. Setting these units will allow you to measure 
distances or compute areas. Display units should also be set if you are planning to create a map layout with a 
distance scale. To set the map and display units:

Right click on the data frame ‘Layers’ at the top of the legend and go down to ‘Properties.’ 

The ‘Data Frame Properties’ dialog box pops up. You should go to the ‘General’ tab. Take a look at the ‘Units’ 
portion of the dialog box. As you can see, the map units are already determined in this case, but you can choose 
what units you would like to use for display. The map units here are ‘decimal degrees’ because all of the data 
added in the Layers are in decimal degrees. Not all data are in decimal degrees. Some data, especially images, 
are in other map units such as metres. To change the display units to metres, follow the steps described below.

zz Select the ‘Display‘units in the Units columns of the ‘General’ tab and change into metres from the dropdown list.

All our data are in Geographic WGS 1984 projection; the metres system that will display is not the correct one. So 
we want to give our view a standard and accurate projection. Bhutan displayed in ‘UTM WGS 1984’ projection 
would be separated into two regions – ‘UTM WGS 1984 45N’ and ‘UTM WGS 1984 46N’ but we can just use 
‘UTM WGS 1984 45N’ in this exercise. To change the data frame projection follow the steps below:
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zz Click on the Coordinate System tab in the Data Frame 
Properties dialog box.

Notice that our current coordinate system ‘GCS_WGS_1984’ is a 
geographic coordinate system.

zz Expand the ‘Projected Coordinate System’ by clicking on the + 
sign box.

zz Scroll down and click on ‘UTM’.
zz Again expand ‘UTM >WGS 1984 > Northern Hemisphere’ 

folder and select ‘WGS 1984 UTM Zone 45N’ projection.
zz Click ‘Apply’ and then ‘OK’.

This will only change the projection of the data frame; it will not 
change the projection of the data.

Measuring in the Map Display 
On the toolbar there is a button that allows you to measure the 
elements of the layers with a measuring tool . You can use this tool to draw a line or polygon on the map and get its 
length or area, or you can click directly on a feature and get measurement information after selecting the appropriate 
tab in the ‘Mearsure’ window that pops up.

zz Click on the measure tool   with the left mouse button. Your 
cursor changes to an L-shaped ruler with cross hairs and you get a 
pop-up window. 

zz Move the cursor to the point on the map where you want to start 
measuring and click. 

zz Now move the cursor to the point where you want to stop 
measuring and double-click. 

The measurement is then displayed in the ‘Measure’ window. This 
measurement is composed of a segment length and total length, i.e., 
you can click and measure several different segments. It also indicates 
the display units of measurement. To change the units, click on the 
drop-down arrow next to the sum symbol. 

You can take measurements that are composed of multiple segments 
that do not follow a straight line. To do so: 

zz Click the measure tool with the left mouse button. 
zz Move the cursor to the point on the map where you want to start 

measuring and click once. 
zz Now move the cursor to the next point along your defined path and click once. The first segment is defined. 
zz Now move to the second point along your defined path and click once. The second segment is defined. 
zz Repeat this process until you reach the point where you want to stop, and click. Double-clicking makes the 

measurement lines disappear again and finishes the measurement. 

You can also measure the area. To measure the area:

zz Select the ‘Measure an Area’    button from the ‘Measure’ 
dialog box.

zz Move the cursor to the point on the map where you want to start 
measuring and click once.

zz Now move the cursor to the next point along your defined path and 
click once. The first segment is defined. 

zz Now move to the second point along your defined path and click 
once. The second segment is defined.
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zz Follow this step and when done double click to complete the polygon. Now you will get the segment, perimeter 
and area of the polygon.

You can also quickly measure the length, perimeter and area of the 
features in the shapefile. 

zz Select the ‘Measure A Feature’    button from the ‘Measure’ 
dialog box.

zz Move the cursor to the feature on the map of which you want to 
measure and click on the feature you want to measure.

zz Now you will get the perimeter and area of polygon (e.g. ‘Basin’) 
or length of the polyline feature, (e.g. Drainage).

Symbolizing Features
Symbolizing features means assigning them colours, markers, sizes, widths, angles, patterns, transparency, and other 
properties by which they can be recognized on a map.

When data sets are added to ArcMap, the symbols and the colours of the features are assigned randomly by 
default. This symbology may not be (and usually is not!) the representation you wish to use for the map. You can 
modify the symbology so that the map is more presentable and readable. In this exercise, you will change the 
symbols and the colours of polygon, line and point features.

zz Open the ArcMap and add the layers from ‘C:\TrainingData\GIS’.

The colors and symbol of the layers and their order may differ on each user screen. Now we will change the 

symbol and colors.

zz In the ‘Table of Contents’ double-click on the circle of the ‘Location’ shapefile using the left mouse button to open 
the ‘Symbol Selector’ window.

You can change the symbol, colour, size, and angle or choose more specific symbols.

zz Select the symbol ‘circle 1’ from the list.
zz In the color option box, click the dropdown box and choose a dark blue color from the color panel.
zz Change the size to 10.
zz Click OK.
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Now you can see the symbol and color of the location point in the Map View.

Repeat for other layers:

zz Click on the line under Drainage layer name.
zz Choose ‘River’; you can also search for the name using the search bar at the top of the ‘Symbol Selector’. 

Because this is already established as an accepted style, the colour and size of the line will be added 
automatically.

zz Click OK to apply the change.
zz Similarly, change the symbol of the ‘Road’ layer to ‘Major Road’.
zz Also click on the polygon under the ‘District’ layer name to change the color of the district boundary.
zz Select a ‘Hallow’ from the list and change the outline color to ‘Red’ and Outline width to 1.
zz Click OK to apply the change.
zz Again click on the polygon under the ‘Bhutan_bnd’ layer name and select the ‘Grey’ symbol from the list.
zz Change the Outline width to 1 and click OK to apply.
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Now we have a much more attractive view. You can experiment with different colors and patterns until you find the 
right ones to suit your final map.

Saving ArcMap Projects
As in other program software, it is good idea to save your project work regularly. 

zz Go to File Menu and select ‘Save’ 
from the file menu, or you can click 
the ‘Save’  icon in the main 
toolbar.

zz Navigate to the folder ‘C:\
TrainingData’ through the save in 
the drop-down menu at the top or 
click on ‘This PC’ and explore to 
the folder where you want to save 
the project 

zz Name the project file ‘Practice1.
mxd’ and click ‘Save’ to save the 
project.

Now your project is saved as a 
‘.mxd’ extension. This stands for map 
document, and it is a GIS-specific file type. If you try to open this document without using the ArcGIS software, it 
won’t work. This file instructs ArcGIS on what data to show and how to display it. The data layers are not stored 
with the .mxd file. If you copy your project file to another disk you must copy all the dataset files used in your project 
to that disk as well or reset the location from the layer properties. 

If you copy the folder containing the .mxd project files and datasets to another drive and you want to link the project 
file and datasets as it is, you have to set the project file as the relative pathname of the datasets. To do this:

zz Open the project file ‘Practice1.mxd’. 
–– 	To open it, go to the File menu and click on ‘Open’ from the File menu list, or directly click the ‘Open’ button 

(Folder icon) on the Standard toolbar.

–– 	Navigate to the folder where you saved your previous project file. (e.g., C:\TrainingData)

zz Go to the File menu and select the ‘Map Document Properties’ from the list.
zz Now the Map Document Properties window will open.
zz Check the ‘Store relative pathnames to data sources’ and click OK to apply the document properties. This will 

preserve the relative path with data and your project file so that even when you copy your data folder and 
project file to another drive, it will not lose the link of the data in your project file.

zz Now click the ‘Save’    icon in the main toolbar or save the document from the File menu to save the 
document properties.

Now you can copy the folder containing the project file and datasets to another disk, and when you open the 
project file from another disk, the link of the datasets is not removed and you don’t need to reset the link of the 
datasets.

Working with Attribute Table and Link to Other Tabular Data
Tabular information is the basis of geographic features, allowing you to visualize, quarry, and analyse data. In the 
simplest terms, tables are made up of rows and columns, and all rows have the same columns. In ArcGIS, rows are 
known as records and columns are fields. Each field can store a specific type of data such as number, date, and 
text.
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Feature classes are really just tables with special fields that contain information about the geometry of the features. 
These include the shape field for point, line, and polygon feature classes and the BLOB field for annotation and 
dimension feature classes. Some fields, such as the unique identifier number (FID, OBJECTID) and Shape, are 
automatically added, populated, and maintained by ArcGIS. To check this information in GIS data:

zz Open the project file ‘Practice1.mxd’. If it is already opened, skip this step.
–– 	To open it, go to File menu and click on ‘Open’ from the File menu list, or directly click the ‘Open’ button 

(Folder icon) in the Standard toolbar.
–– 	Navigate to the folder where you saved your previous project file. (e.g., C:\TrainingData)

zz Right click on the ‘District’ layer on the Table of Contents and click on ‘Open Attribute Table’ form list, or you can 
press the ‘Ctrl’ button on the keyboard and double click on the ‘District’ Layer.

Now you can see the tabular information of the 
feature ‘District’ of Bhutan. In the table, FID are 
the unique feature IDs which are automatically 
added and maintained by ArcGIS when you add 
new features to the layer. The shape field defines 
the type of the features. This is also automatically 
maintained by ArcGIS. Other Fields such as DIST_
CODE, DIST_NAME, Shape_area, Shape_len, 
Pop_2005 can be changed, calculated and 
updated as per the requirements. 

Sources of Tabular Information: There are lots 
of sources of tabular data, and ArcGIS can take 
advantage of many formats. Tabular information 
could be stored as tables in folders or databases, text files, queries on databases, and so on. In addition, if you 
have spatial data, you probably already have tabular attributes that describe those geographic features.

File-based tables are stored in folders on a disk. Some examples of file-based sources of tabular information include:

zz dBASE, the format used with shapefiles;
zz INFO, the format used with coverages;
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zz Text files such as those created in a text editor and delimited by commas or tabs; and
zz Many other sorts of tables, including those generated in other programs, such as Excel, either accessed directly in 

ArcGIS or through the OLE DB functionality.

In ArcMap you can add these table data in the same way you add the GIS files such as Shapefile and raster 
images. For example:

zz Open the project file ‘Practice1.mxd’. If it is already opened, skip this step.
–– 	To open it, go to File menu and click on ‘Open’ from the File menu list, or directly click the ‘Open’ button 

(Folder icon) on the Standard toolbar.
–– 	Navigate to the folder where you saved you previous project file. (e.g., C:\TrainingData)

zz Go to File menu > Add Data and click on Add Data  or directly click the Add  button in the Standard 
toolbar.

zz Navigate to the folder ‘C:\TrainingData\GIS\Tabular’ and double click on ‘Glacier_bhutan.xlsx’ Excel file to 
open the table sheets in the excel file.

zz Select ‘Glacier_Sub-basin$’ table from the list and click the ‘Add’ button to add the selected table in the ArcMap 
project file.

Now you can see the Tabular data ‘Glacier_Sub-basin$’ added to the Table of Contents. If you cannot see it in the 
Table of Contents, you have to change the view options of Table of Contents. To view all the tables and GIS data 
layers, switch the view of ‘Table of Contents’ to ‘List by Source ’.

Now in Table of Contents you will see the Table and all the other GIS data layers will be grouped in their respective 
locations (folder path).

zz Right click on the added tabular data ‘Glacier_Sub-basin$’ layer on the Table of Contents and select ‘Open 
Attribute Table’ form the list or you can press the ‘Ctrl’ button on the keyboard and double click on the ‘Glacier_
Sub-basin$’ layer. 

zz Now the new added table will open.

This table shows the number (num) and area of clean-ice (CI), debris-covered (DC) and total (Tot) glaciers, and 
largest (Large) glacier area in each glacier-fed sub-basin in Bhutan. The number in the field name represents the 
year (‘80’ represents 1980; ‘90’ represents 1990, ‘00’ represents 2000 and ‘10’ represents 2010). For example, 
the field name ‘DC_num_10’ represents the number of debris-covered glaciers in 2010; similarly, ‘CI_area_80’ 
represents the area of clean-ice glacier in 1980. In ArcGIS, you can associate records in one table to record in 
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another table or table of GIS data through a common field, known as a key field. Here in our exercise we can 
associate our new added table to the table of ‘Sub-Basin’ layers. The steps are given below:

Joining the Table.
zz Right click on the ‘Sub-Basin’ layer in the Table of Contents and go to ‘Join and Relates’ in the list then click on 

‘Join’ from the sub-list of Joins and Relates.
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Now the ‘Join Data’ window will open.

zz In the Join data window, select the option ‘Name’ in the 
field for the ‘Sub-Basin’ shapefile in which you are going to 
join the table. 

zz Select the table ‘Glacier_Sub-basin$’ which you are going 
to join from the dropdown list.

zz And in the third list, select the field of the Table ‘Sub-Basin’ 
which is the key field to join the table.

zz Check ‘Keep all records’ in Join Options and Click ‘OK’ to 
join the table.

zz Right click on the added tabular data ‘Sub-Basin’ layer 
on the Table of Contents and click on ‘Open Attribute 
Table’ form the list, or you can press the ‘Ctrl’ button on the 
keyboard and double click on the ‘Sub-basin’ Layer. 

zz Now the table of ‘Sub-basin’ layer will open and you can 
see the joined tabular data in it.

Here in the table you can see all the information in the ‘Glacier_Sub-basin$’ table is joined with the table of ‘Sub-
Basin’. The information not contained in the joined table will show the <Null> values. The Join table shows the 
clean-ice, debris-covered, and total glaciers in the sub-basins of Bhutan from 1980 to 2010. This Join table is just 
temporary, which means that if you open the layer in another project you will not see this Join table in the layer. To 
make it permanent you need to either export this layer to a new file or add the new field in the layer and transfer 
these field values to the new added field. In this exercise, we will add a few new fields and transfer the values from 
Tabular data. 

zz First remove the joined table by right clicking on the ‘Sub-Basin’ layer in the Table of Contents and go to ‘Join and 
Relates’ in the list; then click on ‘Remove Join > Remove All Joins’ from the sub-list. This will remove all the joined 
tables.

39
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Add New Field in the Table
zz Open the Attribute table of the ‘Sub-Basin’ layer.
zz Click the Table Options dropdown button on the top left corner of the opened attribute table of the ‘Sub-Basin’ 

layer.
zz Select ‘Add Field’ from the dropdown list of Table Options.

Now the ‘Add Field’ dialog box will open.

zz In the Name field, type ‘Gr_area_80’. 
zz For field type, select Double from the dropdown list.
zz Leave the Field Properties as default. (Note: In the Field 

Properties, ‘Precision’ indicates the total number digits and 
‘Scale’ indicates the number of digits after decimal degree.)

zz Click ‘OK’ to add a new field.
zz Similarly add other fields named ‘Gr_area_10’ and 

‘Gr_80_10’ in the table.
zz Now you can see three new fields added in the Sub-Basin 

layer.
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Transferring Tabular Data to ‘Sub-Basin’ Layer
zz Again Join the tabular data 

‘Glacier_Sub-basin$’ to the Sub-
Basin layer.

zz Then open the Attribute table of 
the Sub-basin layer; if it is already 
open, jump to the next step.

zz Check whether the Tabular data 
is joined or not by scrolling 
horizontally.

zz Right click on the title of the field 
named ‘Gr_area_80’ and click 
on ‘Field Calculator’ from the 
menu.

zz Now the Field Calculator window will open.
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zz Leave Parser as default (check on VB Script).
zz Double click on the field name [‘Glacier_Sub-basin$’.Tot_area_80] in the Fields list. This will add the Field name 

in the Text area.
zz Click ‘OK’ to transfer data in the new field.
zz Now the value in the field ‘Tot_area_80’ of the joined tabular data ‘Glacier_Sub-basin$’ will transfer to the new 

added field ‘Gr_area_80’ in the table of the ‘Sub-basin’ layer.
zz Similarly transfer the value of the field ‘Tot_area_10’ from the joined tabular data ‘Glacier_Sub-basin$’ to the field 

‘Gr_area_10’ in the table of the ‘Sub-Basin’ layer.
zz Remove the joined table by right clicking on the ‘Sub-Basin’ layer in the Table of Contents and go to ‘Join and 

Relates > Remove Join > Remove All Joins’ from the sub-list.
zz Now you will get the Values in the field ‘Gr_area_80’ and ‘Gr_area_10’. These values indicate the total glacier 

area in the sub-basins during 1980 and 2010.

The glacier area change between 1980 and 2010 is calculated in the field ‘Gr_80_10’. To calculate the glacier 
area change:

zz Right click on title of the Field named ‘Gr_80_10’ and click on Field Calculator from the list.
zz Field Calculator window will open.
zz Leave Parser as default (check on ‘VB Script’).
zz Double click on the field name ‘Gr_area_80’ in the Fields list. This will add the Field name in Text area.
zz Then click on the ‘subtract’ button just above the Text area in the right corner of the window.
zz Click on the field name ‘Gr_area_10’ in the Fields list.
zz Now you see the expression in the Text area as ‘[Gr_area_80] - [Gr_area_10]’.
zz Click ‘OK’ to calculate the field.
zz You will see the glacier area change values in the field ‘Gr_80_10’ for each sub-basin of Bhutan.
zz Similarly you can add other data from the tabular data to the shapefile and calculate change in clean-ice, debris-

covered glacier area. Calculated results in this table stay permanently attached to the shapefile. For instance, the 
‘Sub-basin’ layer (or shapefile?) can be opened in another ArcMap project and the added columns in the table 
will still be there. 

Analysis in the Map Display
ArcMap can helps in analysing data sets by mapping certain attributes of the layer data. Then each object in the 
layer is associated with a set of characteristics or attributes. These attributes, also called fields, are stored in the 
table, which is linked to the features or graphic object, which we view in the Map. Therefore, each object in the 
layer is associated with the records in the layer’s attribute table. We will use this information for analysis.

Analysis within the Attribute Table
zz Open the Attribute table of the Sub-Basin layer.
zz Move the mouse to the top of the table. Right click on the ‘Gr_area_80’ field.
zz Click, with the left mouse button, the ‘Sort Descending’ option on the menu bar.
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zz Now you see the values in the field arranged in descending order.

Notice how the glacier area of 1980 of each sub-basin will arrange themselves in descending order. It thus shows 
which basin has the largest glacier area and which has the lowest. The table shows that the ‘Phochu’ basin has the 
largest glacier area and the ‘Thimchu’ basin has the smallest glacier area. 

Mapping by Category
In ArcMap, you can make the view more informative by assigning a different symbol to each unique value, or to a 
distinct range of values, in the layers attribute table. Let’s give a different colour to each districts of Bhutan.

zz The topmost layer in the ‘Table of Contents’ will be displayed in the map view on the top of the layers. So if you 
need to view a specific layer, you need to uncheck the box adjacent to the name of the layer above the specific 
layer. Now hide all the layers above the District layer in the Table of Contents by unchecking the boxes next to 
the layer names.

zz Right click on the ‘District’ layer and select Properties from the list or double-click on the ‘District’ layer to open the 
properties of the layer.

zz The ‘Layer Properties’ window will open.
zz Click on the ‘Symbology’ tab in the Layer 

properties window.
zz In the ‘Show’ box on left side of the window, 

click on ‘Categories’ and then click on 
‘Unique values’.

zz Choose ‘DIST_NAME’ in the dropdown box 
under the ‘Value’ field.

zz Click the ‘Add All Values’ button on the 
bottom left corner of the window. This process 
will add all the district name values with their 
respective symbols in the category panels. 
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zz You can choose any color ramp from the dropdown box under ‘Color Ramp’ at the top right corner. 
zz Click the ‘Apply’ button to apply the color code in each district polygon and check on the Map view. If you are 

not satisfied with the colors of the district, you can change them from the ‘Color Ramp’ dropdown list.
zz Once you satisfy the symbology you assign to the district layer, click ‘OK’ to apply and close the window.

Now you will see different color codes for different district polygons. You can also apply this to Polyline layer ‘Roads’ 
by using the ‘Type’ field. 

You can also control the colors assigned to each district by double clicking on the colored symbol. It will allow you 
to change the color individually. 

Mapping by Quantity
Now we will analyse data using a common mapping technique called colour maps. These maps are ideal for 
showing all sorts of data including both numerical and descriptive text. In this exercise, we again use the ‘District’ 
layer and prepare maps showing population distribution in the districts.

zz Right click on the ‘District’ layer and select Properties from the list or double-click on the ‘District’ layer to open the 
properties of the layer.

zz The ‘Layer Properties’ window will 
open.

zz Click on the ‘Symbology’ tab in the 
Layer properties window.

zz In the Show box on the left side of 
the window, click on ‘Quantities’ 
and then click on ‘Graduated 
colors’.

zz Choose ‘Pop_2005’ from the 
dropdown menu next to ‘Value’ 
under ‘Fields’.

zz Change the Color Ramp to 
Orange Light to Dark from the 
dropdown list.
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zz Click the ‘OK’ button at the bottom right corner of the layer properties window.

Now you will see the Map changes to display the districts according to population distribution.

In the map, the light colors represent the districts with a 
relatively small population and darker colors represent 
districts with a relatively large population (refer to 
actual numbers in the Table of Contents). 

You can try this process again for the Sub-Basin layer 
with ‘Gr_area_80’ field to see the glacier area 
distribution in the sub-basin from 1980. To see the 
sub-basin layer, it needs to be moved above the 
district layer in the Table of Contents – in order to 
move it, switch to ‘List by drawing order’ . 

You can also portray the data in different ways. You 
can choose your own classification range of value and 
display maps. To do this: 

zz Right click on the ‘District’ layer and open the ‘Layer Properties.’
zz It should automatically come up in symbology 

mode. If not, select the ‘Symbology’ tab. 
zz Also, there should automatically be in “Quantities > 

Graduated” mode and field value is “Pop_2005”. 
If not, repeat the process.

zz Now look at the Classification window at the 
upper leftcorner. It shows that the classification is in 
natural breaks and has 5 classes as default.

zz Click on the ‘Classify’ button.
zz The classification window will open.

In the classification window, the ‘Classification 
Statistics’ section in the upper right corner shows useful 
statistics that may help in analysis such as minimum, 
maximum, mean and standard deviation values. The 



45

Part 2: Introduction to ArcGIS and Hands-on Exercises

44

chart at the bottom left corner shows the break lines in blue color. These break lines can be changed manually by 
clicking on a line with the left mouse button, holding it, moving it to the new area and releasing it. The break values 
is also shown in the ‘Beak Values’ box at the bottom right corner. You can also manually change these values. These 
values are synchronized with the charts.

zz In the classification section, there are multiple methods for classifying the data in the dropdown menu of methods. 
This will automatically classify the value based on the statistics of the values. You need to choose the type of 
classification, number of classes and rounding values. Let’s try this.

zz For ‘Method’, select ‘Quantile’ from dropdown list and for ‘Number of classes’, select 4 from the dropdown list.
zz Click ‘OK’ to apply and close the Classification window.
zz Click ‘OK’ on the 

Layer Properties 
window to change 
the Map.

The view is now 
changed to display four 
colors representing four 
classes.

The new classification 
(Quantile) changes the 
color map into four 
categories with an 
equal number of features 
in each category. 
Test with different 
classification systems in 
the list to see their effect 
on the data view. 

ESRI’s definition of each classification option is given below:

zz Natural Breaks - This is the default classification method in GIS. This method identifies breakpoints between 
classes using a statistical formula (Jenk’s optimization). Natural Breaks finds groupings and patterns inherent in 
your data. 

zz Quantile - In the quantile classification method, each class contains the same number of features. 
zz Equal Interval - The equal interval method divides the range of attribute values into equal sized sub-ranges. The 

features are classified based on those sub-ranges. 
zz Standard Deviations – ArcGIS finds the mean value and then places class breaks above and below the mean at 

intervals of either 1/4, 1/2, or 1 standard deviations until all the data values are contained within the classes.
zz Manual and Defined Interval – it allows you to set your own classification methods.

Density Mapping
The density map is prepared by dividing one attribute (numbers) by another attribute or area of the features. The 
process of dividing one attribute by another to find the ratio between them is called normalization. In this exercise, 
we will calculate the population density as we have the population of the district and area of the district calculated 
from district boundary features in ArcGIS. To calculate the population density, normalize the population data by the 
area of the districts and use graduate colors on the map.

zz Double click on ‘District’ layers in the ‘Table of Contents’ to open the ‘Layer Properties’.
zz It should automatically come up in the Symbology mode. If not, select the ‘Symbology’ tab. 
zz Also, there should be automatically in ‘Quantities > Graduated’ mode and field value is ‘Pop_2005’. If not, 

repeat the process as before.
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zz Now in the Normalization dropdown list, select ‘Shape_area’. This field will divide the field value and give the 
ratio value.

zz Set the color ramp to ‘Yellow to Dark Red’.
zz If necessary, you can also change the Classification mode.
zz Click ‘OK’ to apply.

Now you can see the map showing the relatively higher population density district in red color and low population 
density district in yellow color.

You can also apply this for the number of glaciers in the sub-basin by adding data of total number glaciers in the sub-
basin from the tabular data ‘Glacier_Sub-basin$’.

Another way to map density is by using a ‘dot density map’. To prepare the dot density map:

zz Double click on the ‘District’ layer in the ‘Table of Contents’ to open the Layer Properties.
zz It should come automatically in the ‘Symbology’ tab; if not click on the ‘Symbology’ tab.
zz Click on ‘Quantities’ and then select ‘Dot Density’ in the list.
zz Under the ‘Field Selection’ list double click on ‘Pop_2005’ or select ‘Pop_2005’; then click the right arrow button 

to add it to the box on the right.
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zz In the Densities Calculated section, notice the Dot Value and Dot Size. Change Dot Value to 500, which means 
that each dot in the map represents 500 people.

zz Under the Background section, change the background color of the district to Olivine Yellow by selecting from the 
dropdown list in the square color box.

zz Make sure your ‘Layer Properties’ window matches the above graphic and then click ‘OK’ to apply.
zz Now you will see the dot density map in the Map view.

In the Map view, you will see that the density of the dots is higher in the western part than in the eastern part of 
Bhutan. Each dot in the map represents 500 people.

Chart Maps
Another type of analysis is involves overlaying a chart onto a map. It is a good mapping technique for displaying 
and comparing multiple values or values for each feature. In this exercise, you will analyse the distribution of clean-
ice and debris-covered glaciers in the major basins of Bhutan.

zz To open the Layer Properties window, right-click on the ‘Basin’ layer and click on ‘Properties’ on the right-click 
menu or simply double-click on the ‘Basin’ layer and open the Layer Properties window.
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zz Click on the ‘Symbology’ tab.
zz Click on ‘Charts’ in the Show list box on the left side of the window.
zz Select ‘Pie’ in the chart list.
zz From the ‘Field Selection’ list box on the left hand side, double click on the ‘CI_num_10’ and ‘Dc_num_10’ or 

select both fields (by holding down the Ctrl button on the keyboard and clicking) then click on the right arrow 
button, to move the field on the right 
selection box.

zz Right-click on the rectangular color 
box to CI_num_10 to access a color 
palette. Then select the Ultra Blue color 
from the palette.

zz Similarly change the color of Dc_
num_10 to Electron Gold color.

zz Click on the rectangular box next to 
‘Background’ and select the Yellow 
color symbol from the symbol list and 
click OK.

zz Check the box next to ‘Prevent chart 
overlap’.

zz Click OK to apply.

Now you can see the pie charts showing the distribution of clean-ice glaciers and debris-covered glaciers in the 
major basins.

You can change the size and display in 3D charts by clicking the ‘Size.’ Properties’ in the Layer Properties – 
Symbology tab window.

Similarly you can also make a bar/column graph showing glacier area distribution in the basin.
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Labeling Features

A label is any text that names or describes a feature on a map. In ArcMap, labels are often generated from values in 
the layer attribute table.

There are three types of labels available: dynamic, interactive, and annotation. 

Dynamic Labeling
Dynamic labels are created at once and operate as a group. ArcMap will adjust the label according to the scale 
so that the labels are visible. Although you can set rules for display, ArcMap decides where to place them. As a 
default, labels will not overlap. In addition, you cannot individually select or change them unless you convert them to 
annotation.

zz Right-click on ‘District’ and select ‘Properties’ from 
the list. This opens the ‘Layer Properties’ window. 
You can also double click on the layer to open the 
‘Layer Properties’ window.

zz Click on the ‘Labels’ tab and check the box next to 
‘Label features in this layer’.

zz Select ‘DIST_NAME’ from the ‘Label Field’ 
dropdown menu.

zz Click ‘Apply’ and check on the Map view.
zz Each district is now labeled and ArcMap tries to 

place the labels at the centre of the polygon. You 
can change the font, color, shading and position of 
the labels.

zz Stay on the ‘Layer Properties’ tab. 
zz Click the ‘Symbol’ button. The ‘Symbol Selector’ 

dialog box opens.
zz In the ‘Options’ section of the ‘Symbol Selector’, 

click on the ‘Color’ dropdown palette and select 
the dark navy color. Choose font ‘Arial’ and Size 
‘10’ and make it ‘B’ (bold). 

zz Click the ‘Edit Symbol’ button on the ‘Symbol 
Selector. The Editor window will open.

zz Select the ‘Formatted Text’ tab and click on ‘All 
Caps’ in the ‘Text Case’ section. Also change the 
‘Character Spacing’ value to 25 and click ‘OK’ to 
apply the symbol properties.

zz Click the ‘OK’ button on the ‘Symbol Selector’ 
window and then click ‘OK’ on the ‘Layer 
Properties’ window.

zz Now you see the labeled map of the district.
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You can also practise labeling the map of point data (Location layer), and explore the ‘Placement Properties’ in the 
Labeling Layer Properties.

Querying Data
In ArcGIS, we can find precise information quickly by using queries. This can help us to find patterns in the data.

Querying By Attribute
zz Click on the ‘Selection’ menu in the main menu bar 

and then ‘Select by Attributes’ from the list to open 
the ‘Select by Attributes’ window.

The query window allows you to choose the layer on 
which you would like to query and changes the list of 
layer attributes below depending on what you pick 
from the drop down menu. It also contains a set of 
operational tools in the left side of the middle section 
and all the table values for each attribute on the right 
side of the middle section. The operational tools 
including the standard mathematical ones =, >, >, etc. 
as well as the Boolean operators - ‘and’, ‘or’ and ‘not’. 
To build a query, first select an attribute and then an 
operator to perform with its values.

Start the exercise with a simple query:

zz Change the ‘Layer’ list drop down box to ‘District’.
zz Under ‘Method’, select ‘Create new Selection’.
zz Double-click on the attribute ‘DIST_NAME’; this will 

add the field name in the expression box below.
zz Then click on the ‘=’ sign operation.
zz Click on the ‘Get Unique Values’ button. A list of attributes will appear in the box on the right.
zz Finally, in the box listing the attributes, double-click on ‘Bumthang’. The name Bumthang appears in the query 

builder box.
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zz Verify that your query looks the same as the image above and click ‘OK’ to apply and close the “Select By 
Attribute” window.

Now in the Map view, the boundary of ‘Bumthang’ district is highlighted in aqua color. Arcmap always highlights 
selected objects in aqua as the default.

Export the Selected Features as a New Map Layer
Now the selected Bumthang district boundary can be exported from the map as a new layer and added in the same 
project. This will help you define the area of interest for your work as well as extract other features from the larger 
database for the specific area ‘Bumthang’.

zz Right-click on the ‘District’ layer to open the right-click menu.
zz Go to ‘Data’ and click on ‘Export Data’ on the menu.

Now the ‘Export Data’ menu will open.
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zz Choose ‘Selected features’ from the Export dropdown 
menu; under ‘Use the same coordinate system as’, select 
the option ‘this layer’s source data’.

zz Click on the folder icon to choose the location and 
filename.

zz Save the file in the appropriate folder (C:\
TrainingData\GIS\temp, if there is no temp folder, 
create one) and name the file ‘Bumthang’ and select 
‘Shapefile’ for ‘Save as type’. 

zz Click ‘OK’ and then a dialog box will open. It will ask 
you if you wish to add the exported data to the map as 
a layer or not. Choose ‘Yes’ to add the exported data in 
ArcMap.

zz Then the new layer ‘Bumthang’ will appear on the map 
and is added to the ‘Table of Contents’ at the bottom.

Spatial Queries: Select by Location
This exercise will let you select features based on their location relative 
to features in another layer. For example, if you want to know how 
many villages or major settlements lie within Bumthang district, you 
can select all the settlement location points that lie within the Bumthang 
district boundary.

zz Click on the ‘Selection’ menu in the main menu bar and then ‘Select 
by Location’ from the list to open the ‘Select by Location’ window.

zz From the dropdown list of ‘Selection Method’ options, choose 
‘select features from’.

zz Check the box ‘Location’ under the option ‘Target layer(s)’.
zz Check the box next to ‘only show selectable layers’.
zz From the dropdown list for ‘Source layer’, select the ‘Bhumthang’ 

layer.
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zz And select ‘intersect the source layer feature’ from the ‘Spatial selection method for target layer feature(s)’ 
dropdown list.

zz Click ‘Apply’ and then ‘OK’.
zz Now you will see the selection of Location point only in Bhumthang district on the map.

Now you can export these selected points as new layers so that you will get only locations that lie within the 
Bhumthang district boundary.

Map Layout
Map layout is a way of allowing you to make professional quality presentations. It is a collection of map elements 
laid out and organized on a page, designed for map printing. Common map elements that are arranged in the 
layout include one or more data frames (each containing an ordered set of layers), a scale bar, north arrow, map 
title, descriptive text and a symbol legend. In a map layout, we can also include tables and charts. We have thus 
far worked in ‘Map View’ and maps are created in ‘Layout View’. To make the transition from map view to layout 
easier, a few things should be done in map display.

zz Set the map and display units first. This needs to be done before a scale is placed on the layout.
zz Choose appropriate colors for your map.
zz Give names tomap view and layers. These names will be used to title the map and label the legend.

In this exercise we will make a simple district map of Bhutan with road networks.

zz First clear all of the selection of Objects or features by clicking on the ‘Clear Selected Features’ button  on the 
standard toolbar.

zz Make sure that the layers that will be included in the Map Layout have appropriate colors and symbols.
–– 	Change the symbology of the ‘District’ layer to ‘Categories > Unique values’ of ‘DIST_NAME’ field with your 

appropriate ‘Color Ramp’. 
–– 	Similarly change the symbology of the ‘Road’ layers using the ‘Type’ field (black color and 1 to 2 point width 

for highway and dzongkhag roads, and dark grey color and 0.5 to 1 point width for other roads). You can 
change these properties by double-clicking on the ‘Symbol’ itself. 

–– 	Also place the ‘Bhutan_bnd’ layer above the ‘District’ layer using drag and drop. And change the symbology 
to ‘Hollow’ and outline to ‘Boundary National’.
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zz Label the features that you want to put on the map.
zz Provide meaningful names to the layers, so that they are nicely displayed in a legend on the map. 

–– 	Right click on ‘Bhutan_bnd’ layer and click on ‘Properties’ in the list or double click on the ‘Bhutan_bnd’ layer 
to open the ‘Layer Properties’ window.

–– 	Click the ‘General’ tab.
–– 	Under the ‘Layer Name’ text box, change the name to ‘Bhutan boundary’ and keep ‘Visible’ checked.
–– 	Click ‘OK’ to apply the change and close the ‘Layer Properties’ window.

Repeat this process on other layers where changes are necessary.

If all the steps (changing colors, symbology, naming the layers and sequencing) have been completed satisfactorily, 
it’s time for layout.

zz Switch the ‘Map View’ mode to ‘Layout’ by clicking on the ‘Layout’ button at the bottom left corner of the ‘Map 
View’   or go to the ‘View’ menu in the main menu bar and click on the ‘Layout View’ on the 
list.
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Now you can see the Layout view with box of data frame and page alignment. The alignment of the data frame 
boundary and page will not match. So you can change the data frame boundary by dragging the boundary node 
points. Before setting the data frame boundary, you have to set up the page format.

To Set up the Page Format
zz Go to ‘File’ menu and click on the ‘Page and Print Setup’. ‘Page and Print Setup’ window will open.
zz In the Paper section, select the Paper size ‘A4’ from the dropdown menu and ‘Automatically Select’ for ‘Source’.
zz Select the ‘Landscape’ paper orientation for the present exercise. 
zz Check the box next to ‘Use Printer Paper Settings’ on the Map Page Size section and ‘Scale Map Elements 

proportionally to change in Page Size’ box on the bottom right corner of the window.
zz Click ‘OK’ to apply the change and close the window.

As you will see, the page in the Layout view will now change to Landscape. You can set the boundary of the data 
frame to fit the page by dragging the node points of the data frame boundary. Make the data frame boundary fit the 
page, as shown in the figure below.
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You can use Zoom and Pan tools to fix the Data view in the data frame.

Also notice that the Layout toolbar is now activated.

 

From here it is possible to zoom in, zoom out, pan, fixed zoom in, fixed zoom out, zoom to whole page, zoom to 
100%, go back and forward between extents, and change the percentage of your zooming. If you want to quickly 
zoom in to the extent of the Bhutan boundary, just right click on the Bhutan boundary layer in ‘Table of Contents’ and 
select ‘Zoom to Layer’ from the list. Practise using these tools to become familiar with them.

Adding a Title, Scale Bar, North Arrow, and Legend
zz In the Menu bar, click the ‘Insert’ menu. The list of options on the Insert menu will open. This menu allows you to 

add various elements to the layout.

zz Click on ‘Title’ and a ‘Title’ box will appear on the layout 
with the name you choose when you saved the project. It 
is possible to change the name by clicking on the box and 
typing in new text. Place the ‘Title’ at the top of the Map 
Layout by dragging and dropping in the right position.

Adding North Arrow
zz Click the ‘Insert’ menu and select ‘North Arrow’ from the 

list. The ‘North Arrow Selector’ window will open.
zz Select ‘ESRI North 3’ from the list and click ‘OK’ to add 

the North arrow.
zz Click the North arrow and drag it to the right corner of 

the map layout within the data frame boundary. Or place 
it in a location you think is appropriate.
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Adding a Scale Bar
zz Click the ‘Insert’ menu and select ‘Scale Bar’. The 

‘Scale Bar Selector’ window will open.

zz From the left box of the ‘Scale Bar Selector’ 
window, select ‘Double Alternating Scale Bar1’.

zz Then click the ‘Properties’ button on the right side of 
the window. The scale bar properties window will 
open.

zz On the ‘Scale and Units’ tab of the ‘Scale Bar’ window, set the values 
‘Number of Divisions’ and ‘Number of Subdivisions’ to 2. Check the 
box next to ‘Show one division before zero’. For ‘Division Units’, select 
‘Kilometres’ from the dropdown list.

zz Click ‘OK’ to apply the scale bar properties and to close the window.
zz Click ‘OK’ on the ‘Scale Bar Selector’ window to apply and close the 

window.
zz Now you will see the Scale Bar added in the Layout. 
zz By default the Scale Bar will appear in the middle of the page. So move 

the scale bar by selecting it and drag it to the lower left corner of the 
Map just inside the left corner of the Data Frame boundary.

zz Also if you select the note point of the scale bar boundary and drag 
in/out, ArcGIS will automatically set the size and scale of the font and 
scale bar.
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Adding Legend
zz Before adding the Legend, you have set all the layer names and symbols as you would like them to be displayed 

on the Map. 
zz Click the ‘Insert’ menu and select and click on ‘Legend’. The ‘Legend Wizard’ window will open.

zz In the ‘Legend Wizard’ window, there are two boxes – ‘Map 
Layers’ on the left and ‘Legend Items’ on the right and in 
between there are four arrow buttons. Now select the Layers 
from the ‘Map Layers’ box that you want to add in legend and 
move to the Legend Items box by clicking the single 
arrow button pointing towards the ‘Legend Items’. 
Similarly for layers you do not want to display in the 
Legend on the Map, remove them from the Legend 
Items by selecting and clicking on the single arrow 
button pointing towards the Map Layers.

zz On the right side of the Legend, there are four arrow 
buttons pointing downward and upward. You can 
use these buttons to arrange the sequence of the 
Layer one after another to show in the legend of the 
map.

zz Once you select the Legend items and arrange them 
in the sequence you’d like to display on the map, 
click the ‘Next’ button. Now it will allow you to 
format the Legend title. Here you can change the Title 
name of the Legend and formats of the title name.

zz Click ‘Next’.
zz In the next window, you can set the Legend Frame 

background and boundary. For ‘Border’ type, 
select ‘0.5point’ from the dropdown list and for 
‘Background’ select ‘Grey 10%’. Then leave the 
others as default and click the ‘Next’ button.
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zz Now in the next window you can change the size 
and shape of the symbol patch used to represent 
the features in the legend. Select the items from 
the ‘Legend Items’ box on the left side and change 
the width, height, line type and area type in the 
‘Patch’ section on the right side of the window. At 
the moment leave it as default and click the ‘Next’ 
button on the bottom right corner of the window.

zz Again in the next window you can set the spacing 
between the parts of the legend. But for now leave 
it as default and click the ‘Finish’ button to add the 
Legend in the map and close the ‘Legend Wizard’ 
window.

zz By default the legend will appear in the middle of 
the layout. You can move the legend by clicking on 
the legend box and dragging and dropping it on 
the right side of the layout, as shown in the figure 
below. You can also select the node corner point 
of the legend box and adjust the size of the box 
to fit the layout page. While you adjust the legend 
box size ArcGIS will automatically set the size and 
shape of the elements in the legend box.
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Adding Grids and Graticlues
A grid is a network of evenly spaced horizontal and vertical lines used to identify locations on a map. For example, 
you can place a grid that divides a map into a specified number of rows and columns by choosing the reference 
grid type. Often, the row and column labels of a reference grid identify locations listed in a map index.

You can also use grids to display measured locations using projected coordinates on the map. There are numerous 
ways to display measured grids.

Graticules are lines showing parallels of latitude and meridians of longitude for the earth. Graticules can be used to 
show location in geographic coordinates (degrees of latitude and longitude).

Usually, to add the grids or graticules in the layout you need to set the coordinate system of the data frame. For 
reference grids, you have to set the data frame as projected coordinate system and for the graticules line you have 
to set the coordinate system of the data frame as ‘Geographic Coordinate System’. In the new version of ArcGIS 
(version 10.x), if you set the coordinate system of the data frame, the 
system will automatically set the grids and graticules, but it’s better to set 
the respective coordinate system in the data frame. In this exercise, we will 
add the graticules on the map.

Double click on the data frame or right click on the data frame in the 
‘Table of Contents’ and select ‘Properties’ from the list. The ‘Data Frame 
Properties’ window will open.

zz Click on the ‘Grids’ tab.
zz Click the ‘New Grid’ button on the left side of the ‘Grid’ tab window. 

The ‘Grid and Graticules Wizard’ will open.
zz Here you have three options of grids you want to add on the map – 

Graticule, Measured Grid and Reference Grid. Check the radio button 
next to ‘Graticule’ and type the ‘Grid name’ if you want. 

zz Click the ‘Next’ button. In the next window you can change the Appearance and Intervals of the grids. Select 
the ‘Graticule and labels’ in the Appearance section and set the interval to 30 min in both the parallels and 
meridians.
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zz Click the ‘Next’ button and it will allow you to format the axes and labels. For now leave it as default.
zz Again click the ‘Next’ button and here it will allow you to create graticule line and its formats. You can leave this 

part also as default.
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zz Click ‘Finish’ to add the graticule lines and close the window.
zz Now in the left box on the ‘Grids’ tab window of the ‘Data Frame 

Properties’ window, you will see an item named Graticule with a 
box checked. On the right side of the window all the buttons are 
highlighted. 

zz Select the item in the left box and click the ‘Properties’ button. The 
‘Reference System Properties’ window will appear, where you can 
again format the graticule lines and labels and display properties. 

zz Go to ‘Labels’ on the ‘Reference System Properties’ 
window and check the ‘Left’ and ‘Right’ check boxes in the 
Vertical Labels Orientation section. Then click ‘OK’ to apply.

zz Also click ‘OK’ on the ‘Data Frame Properties’ button to add the graticule lines on the map.
zz Now you will see the graticule lines on the map. If the graticule lines are dense or do not appear clear or you 

are not satisfied with the view, you can change it by opening the Data frame properties > Grids tab and select 
‘Open the properties’ of the graticules you added.

Now arrange the elements of the map layouts so that it looks good.
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Export or Print the Map
zz Once the layout is done, you can print it by pressing the print button in the standard toolbar or by selecting ‘File 

> Print’ from the menu bar. 
zz When the print window opens, set the printer and paper format then press the ‘OK’ button to print.

You can also export the map in a variety of file types.

zz From the menu bar select ‘File > Export Map’.
zz The ‘Export Map’ window will open where you can choose the location, output filename and type, resolution 

and the extent of output map.
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2.3	 ArcToolbox and Extensions in ArcGIS
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ArcToolbox
ArcToolbox is the third application of ArcGIS Desktop. Although it is not accessible from the start menu, it is easily 
accessed and used within ArcMap and ArcCatalog. ArcToolbox contains 
tools for geoprocessing, data conversion, coordinate systems, projections, 
and more.

The ArcToolbox is the central place where you find, manage, and execute 
geoprocessing tools. It contains toolboxes, which in turn contain tools and 
toolsets (a toolset is just an organizational device, like a system folder). 
Tools must be contained in a toolbox – they cannot exist outside a toolbox.

A toolbox is a file in a folder on a disk or a dataset in a geodatabase. 
Toolboxes in a folder have a .tbx extension. They can be easily copied and 
moved.

ArcGIS ships with a dozen or so toolboxes; the exact number depends on 
what extensions you have installed. Toolboxes installed with ArcGIS are 
referred to as system toolboxes. The organization of the system toolboxes—
their names and the tools and toolsets they contain—has been carefully 
thought out to provide a logical and coherent collection of tools.

Geoprocessing through ArcToolbox
According to ESRI, geoprocessing refers to the tools and processes used to 
generate derived data sets. The derived data is a new file that results from 
taking a data layer and processing it.

There are many tools and ways to conduct geoprocessingin ArcGIS. But we 
only look at a few most common geoprocessing operations such as buffer, clip, dissolve, intersect and spatial join.

ArcToolbox allows us to perform these operations through sets of toolboxes. We will be using the Analysis and Data 
Management toolboxes. Within these main toolboxes, operations are grouped by the way that the derived data set 
is created.

zz Open new ArcMap projects.
zz Add the ‘Bhumthang’ district layer from ‘C:\TrainingData\GIS\temp’, 

which was exported from the ‘District’ layer in the previous exercise, and 
‘Location’, ‘District’ and ‘Glacier’ from the ‘C:\TrainingData\GIS’.

zz You can change the symbology as you like and save the project as 
‘Practice2.mxd’ at ‘C:\TrainingData’.

zz Now open the ArcToolbox by clicking the ‘Arctoolbox’ button in the 
standard toolbar. The ArcToolbox window will open.

ArcToolbox window

Toolbox

Toolset

Tool
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Buffer
It is a zone around features measured in units of distance or time. It is useful for proximity analysis. It can also be 
defined as an area bounding the region determined by a set of points at a specified maximum distance from all 
nodes along the segments of an object. For instance, we will just use the Bhmthang district boundary to identify 
where the area lies within the 100 m distance from the Bumthang district boundary.

zz Click on the Plus sign 
next to ‘Analysis Tools’.

zz Single click on the 
plus sign next to the 
‘Proximity’ toolset.

zz Double click on the 
‘Buffer’ tool. The buffer 
window will open.

zz In the ‘Input Features’ 
box at the top choose 
the ‘Bhumthang’ layer 
from the dropdown list.

zz Using the browse icon 
navigate to the ‘C:\
TrainingData\Gis\Temp’ 
folder in the box for 
‘Output Feature Class’ 
and name the new file 
‘Bhumthang_buffer100 m’.

zz Under the ‘Distance’ section, type 100 in the ‘Linear unit’ box and select ‘Meters’ from the dropdown menu.
zz Leave other functions as default and click the ‘OK’ button. You will see a little process window at the bottom of 

the screen, and when the process is complete a new layer will be added in the project.
zz Select the new created layers and change the symbology to ‘Hollow’. Zoom to the boundary of the new layers 

and measure the distance between the boundary of the ‘Bhumthang’ layer and new ‘Bhumthang_buffer100 m’ 
layer. 

Here in the figure the pink filled polygon is the Bhumthang boundary and Black thick outline is boundary with 100 m 
buffer of the Bhumthang district boundary.
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Clip Operation
This will cut out a feature using another feature. This is useful for creating a new feature class or a new shapefile of 
subset of feature in another, larger feature shapefile. In this exercise, you will use the Bumthang district boundary to 
cut out glaciers lies within Bumthang from the glacier shapefile of Bhutan.

zz Re-open the ArcToolbox window if 
it is not already open.

zz Under Analysis > Extract, 
double click on the ‘Clip’ tool 
in the ArcToolbox or click on 
Geoprocessing > Clip on the 
menu bar. The ‘Clip’ window will 
open.

zz Under ‘Input Features’, select the 
‘Glacier’ layer from the dropdown 
list.

zz Under ‘Clip Features’, select 
the ‘Bhumthang’ layer from the 
dropdown list.

zz On the ‘Output Feature Class’, 
click on the folder icon and 
navigate to the folder ‘C:\
TrainingData\GIS\Temp’, then name the output file ‘Glacier_Bumthang.shp’ and click the ‘Save’ button to close 
the window.

zz Click the ‘OK’ button to process the command. You will see a little process window at the bottom of the screen, 
and when the process is complete a new layer will be added in the project.
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You will see the new ‘Glacier_Bumthang’ layer in the map view. You can open the ‘Attribute Table’ of the layer. Then 
check the number of glaciers in Bumthang district and you can also summarize the area of glaciers to obtain the 
largest glacier area and total glacier area in Bumthang district. To summarize the area:

zz Open the ‘Attribute Table’ of the layer ‘Glacier_Bumthang’.
zz Right click on the ‘Area_SqKm’ field and click on ‘Statistics’ on the list.

Now the ‘Statistics of Glacier_Bumthang’ window will open.

In the window, the left ‘Statistics’ box contains the summary of the field you selected from the ‘Field’ dropdown list. 
In the ‘Statistics’ box the count value represents the total number of glaciers, minimum value represents the smallest 
glacier area, maximum value represents the largest glacier area and the sum value represents the total glacier area 
in Bumthang district.

Spatial Join
This tool appends the attribute of one layer to another layer based on the relative locations of the features in the 
two layers. In this exercise, we will use the glacier shapefile and district shapefile of Bhutan and join as one-to-one 
operation taking glacier shapefile as the target layer. This will add all the district names including other attribute fields 
in the district shapefile in glacier features. Later we will summarize the area of glacier based on the added district 
name values in the field, which will give us the status of glaciers in each district.
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zz Re-open the ArcToolbox window if it is not already open.
zz Under ‘Analysis Tools’ > ‘Overlay’ toolset, double click the ‘Spatial Join’ tool in the ArcToolbox. The ‘Spatial Join’ 

window will open.
zz Under ‘Target Features’, select the ‘Glacier’ layer from the dropdown list.
zz Under ‘Join Features’, select the ‘District’ layer from the dropdown list.

zz On the ‘Output Feature Class’, click on folder icon and navigate to the folder ‘C:\TrainingData\GIS\Temp’, then 
name the output file ‘Glacier_Bhutan.shp’ and click the ‘Save’ button to close the window.

zz Select ‘JOIN_ONE_TO_ONE’ in the ‘Join Operation’ and check the box for ‘Keep All Target Features’. 
zz Click the ‘OK’ button to process the command. You will see a little process window at the bottom of the screen, 

and when the process is complete a new layer will be added in the project.
zz Open the Attribute table of the new added layer ‘Glacier_Bhutan’ and scroll to the right side for the table to see 

the join table of the ‘District’ layer (‘DIST_NAME’).
zz Now you can summarize the table to know the statistics of glaciers in each district of Bhutan. To do this follow 

these steps:
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–– 	Right click on the ‘DIST_NAME’ file and click 
on ‘Summarize’ in the list. The ‘Summarize’ 
window will open.

–– 	Select ‘DIST_NAME’ from the dropdown list 
under ‘Select a field to summarize’ at the top of 
the ‘Summarize’ window.

–– 	Scroll down to the middle box to see the ‘Area_
SqKm’ field. Click on the plus sign of the ‘Area_
SqKm’ and check the boxes next to Minimum, 
Maximum and Sum under the ‘Area_SqKm’ tree 
menu.

–– 	On the ‘Specify output table’, click on the 
folder icon and navigate to the folder ‘C:\
TrainingData\GIS\Temp’, then name the output 
file ‘Glacier_Summary.dbf’ and select ‘dBASE 
Table’ in the ‘Save as type’ dropdown list, then 
click the ‘Save’ button to close the window.

–– 	Click the ‘OK’ button to get the ‘Summarize’ 
table. A dialog box will open asking whether 
you’d like to add the result table on the map or 
not. Click the ‘Yes’ button to add the result table on the map.

–– 	Now it will take some time to process and when it’s done, the new summary table will be added to the ‘Table 
of Contents’. Scroll down the ‘Table of Contents’ to view the new added table.

–– 	Open the Table by right clicking on it and select Open from the list. Now the summary table will open. It 
shows the total number of glaciers in the each district in the ‘Count_DIST_NAME’ field, smallest glacier area 
in the ‘Minimum_DIST_NAME’ field, largest glacier area in the ‘Maximum_DIST_NAME’ field and total 
glacier area in the ‘Sum_DIST_NAME’ field. You can note down the names of the districts containing the 
highest glacier area and number, largest glacier.
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Extensions in ArcGIS
ArcGIS has a suite of extensions that provide extended capabilities to the core product. The categories of extensions 
include analysis, data integration and editing, publishing, and cartography. With ArcGIS extensions, we can:

zz Analyse data in a realistic perspective; 
zz Conduct advanced spatial analysis to get specific answers from data;
zz Use advanced statistical tools to investigate data;
zz Perform complex routing, closest facility, and service area analysis;
zz Reveal and analyse time-based patterns and trends; and
zz Represent and understand your network.

ArcGIS Network Analyst, ArcGIS StreetMap, ArcGIS 3D Analyst, ArcGIS Geostatistical Analyst, ArcGIS ArcScan, 
ArcGIS Tracking Analyst and ArcGIS Business Analyst are some of the examples of ArcGIS extensions. But in this 
exercise we only use some basic ArcGIS Spatial Analyst tools.

Spatial Analyst
The data structure used in the previous exercise is just vector data as discrete boundaries and location like district 
boundary, glacier boundary, and location point so on. But analysing continuous data models over space such as 
elevation, slope aspect, the rater data can be particularly useful in understanding the reasons for spatial patterns. As 
already described in the previous section, the raster data is composed of a two-dimensional matrix of grid cells, with 
numeric values assign to each cell. In this section we will work through some tools to analyse using raster data.

The spatial analyst provides a broad range of powerful spatial modelling and analysis tools. You can create, query, 
map, and analyse raster data; perform integrated raster/vector analysis; derive new information from existing data; 
query information across multiple data layers; and fully integrate raster data with traditional vector data sources. 
Integrated with the geoprocessing framework, ArcGIS Spatial Analyst provides easy access to numerous functions in 
ModelBuilder™, a graphic modelling tool.

With ArcGIS Spatial analyst, we can:

zz Convert features (point, line, or polygon) to rasters;
zz Create raster buffers based on distance from or proximity to features or rasters;
zz Generate density maps and continuous surfaces from point features; 
zz Derive contour, slope, viewshed, aspect, and hill shades 

of these surfaces;
zz Perform map algebra (Boolean queries and algebraic 

calculations); 
zz Conduct neighbourhood and zone analyses;
zz Carry out discrete cell-by-cell analysis; and
zz Perform classification and display.

A license is required to activate the Spatial Analyst 
extension. To activate the extension:

zz Open a new ArcMap Project.
zz Click on the ‘Customize’ menu and select ‘Extensions…’ 

from the list. The extension window will open.
zz Turn on ‘Spatial Analyst’ by checking the box next to 

‘Spatial Analyst’.
zz Close the window by clicking the ‘Close’ button on the 

bottom right corner of the window.
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Now you can use Spatial Analyst to analyse the raster data. In this exercise, you will use DEM data (SRTM DEM) 
of Bhutan and generate various topographic features such as slope, aspect, hillshade, etc. and you will also use 
some mathematical operations for analysis using these raster data. Before generating different surface features and 
mathematical operations of DEM data, you need to project the data in a projected system. We generally use the 
UTM zone projections – for Bhutan we will use UTM 45N zones. So first check the coordinate system of the dem 
data by opening the properties of the data; if the coordinate system of the data is in geographic, you need to 
change the coordinate system into the UTM projected system. To change the projection system of DEM data perform 
the following steps:

zz Add the ‘Dem.tif’ raster data from ‘C:\TrainingData\GIS’.
zz Open the properties of the ‘Dem.tif’ by double clicking on it. The layer properties window will open.

zz Click on the ‘Source’ tab. You can see the properties of the raster layer. You can scroll down the property box to 
see the all the properties of the raster layer. Note the cell size, which represents the resolution of the layer and 
also note the spatial reference of the raster layer. This spatial reference of this layer is in Geographic Coordinate 
System (default of data frame?). So in order to analyse the raster data it is better to use a Projected Coordinate 
System. So the data need to change their spatial reference. To do this:

zz Close the Layer properties window and Open ArcToolbox. 
zz Go to ‘Data Management Tools’ > ‘Projections and Transformations’ > ‘Raster’ and double click on ‘Project 

Raster’. The Project Raster window will open.
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zz Under ‘Input Raster’, select ‘Dem.tif’ from the 
dropdown list.

zz On the ‘Output Raster Dataset’, click on the folder 
icon and navigate to the folder ‘C:\TrainingData\
GIS’, then name the output file ‘Dem45N.tif’ and 
click on ‘Save’ to close the window.

zz Under ‘Output Coordinate System’, click on the 
icon  to open the ‘Spatial Reference Properties’ 
window. 

zz Click on the plus sign of the ‘Projected Coordinate 
Systems’ to expand the tree menu and again 
expand the tree menu of ‘UTM > WGS 1984 > 
Northern Hemisphere’. 

zz Scroll down the Projection file list box and select 
the ‘WGS 1984 UTM Zone 45N’ projection and 
click ‘OK’ to apply and close the window.

zz Note: Bhutan actually falls in two UTM projection 
zones – ‘WGS 1984 UTM Zone 45N’ and 
‘WGS 1984 UTM Zone 46N’ but in this exercise 
we used the ‘WGS 1984 UTM Zone 45N’. If you 
are going to do the real work, it is better to divide 
the area into two projections and process it.

zz Under the ‘Resampling Technique (optional)’, select ‘Cubic’.
zz Leave all other functions as default and click ‘OK’ to process. You will see a little process window at the bottom 

of the screen, and when the process is complete a new layer ‘Dem45N.tif’ will be added in the project.
zz You can change the symbology of the Dem layer by opening the Layer Properties > Symbology tab.
zz Save the project as ‘Practice3.mxd in “C:\Trainingdata\’.

Now we will use this layer for further exercise.

Slope Map
Slope data tells the steepness of the terrain. This data is useful for a variety of determinations such as likelihood of 
flooding, likelihood of occurrence of landslide, best places for settlements, and agriculture, possibility of occurrence 
of different types of glaciers and its characteristics, etc.

zz In the ArcToolbox, go to ‘Spatial Analyst Tools > Surface’ and double click on ‘Slope’. The ‘Slope’ window will 
open.



74

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part 2: Glacier Database Generation using ArcGIS

zz Under the ‘Input Raster’, choose ‘Dem45N.tif’ from the dropdown list.
zz Under the ‘Output Raster’, click on the folder icon and navigate to the folder ‘C:\TrainingData\GIS’, then name 

the output file ‘slope.tif’ and click the ‘Save’ button to close the window.
zz Select ‘DEGREE’ from the ‘Output Measurement’ dropdown list.
zz Set the ‘Z factor’ to ‘1’.
zz Click the ‘OK’ button to process and close the window. You will see a little process window at the bottom of the 

screen, and when the process is complete a new layer ‘slope. Tif’ will be added in the project.
zz Now you will see the new slope data added in the map view with its standard classified symbology, as shown in 

map below.

Aspect Map
It gives the directions faced by the topographic slopes, usually measured in degrees from north. It is useful for the 
identification of water flow direction, characterization of various features and various other flow modelling. It can be 
generated from DEM. The following steps will give you the aspect data.

zz In the ArcToolbox, go to ‘Spatial Analyst Tools > Surface’ and double click on ‘Aspect’. The ‘Aspect’ window will 
open.

zz Under the ‘Input Raster’, choose the ‘Dem45N.tif’ layer from the dropdown list.
zz Under the ‘Output Raster’, click on the folder icon and navigate to the folder ‘C:\TrainingData\GIS’, then name 

the output file ‘Aspect.tif’ and click the ‘Save’ button 
to close the window.

zz Click the ‘OK’ button to process and close the 
window. You will see a little process window at 
the bottom of the screen, and when the process is 
complete a new layer ‘Aspect.tif’ will added in the 
project.

zz Now you will see the new Aspect data added in 
the map view with it standard classified symbology 
as shown in map below.
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Hillshade
It is a grey scale 3D representation of the surface, with the sun’s relative position taken into account for shading the 
images. It uses the altitude and azimuth properties to specify the sun’s position. This data is useful for enhancing 
visualization of 2D surface data to 3D view, which will greatly aid visual analysis and graphical display of the data. 
Hillshade can also directly generated using DEM data and just changing the Azimuth angles and altitude of the sun’s 
position in the tool.

zz In the ArcToolbox, go to ‘Spatial Analyst Tools 
> Surface’ and double click on ‘Hillshade’. The 
‘Hillshade’ window will open.

zz Under the ‘Input Raster’, choose ‘Dem45N.tif’ layer 
from the dropdown list.

zz Under the ‘Output Raster’, click on the folder icon 
and navigate to the folder ‘C:\TrainingData\GIS’, 
then name the output file ‘Hillshade.tif’ and click the 
‘Save’ button to close the window.

zz Leave the Azimuth value as default and set the 
Altitude value to 60 degrees as the terrain of 
Bhutan is quite steep and if we increase the Altitude 
values it will decrease the shadow area in the 
output, as this altitude values represent the light source above the horizon.

zz Leave other functions as default.
zz Click the ‘OK’ button to process and close the window. You will see a little process window at the bottom of the 

screen, and when the process is complete a new layer ‘Hillshade.tif’ will be added in the project.
zz Now you will see the new Hillshade layer added in the map view with its standard classified symbology, as 

shown in the map below.



76

Training Manual on Application of RS and GIS for Mapping and Monitoring of Glaciers: Part 2: Glacier Database Generation using ArcGIS

Spatial Analysis using Map Algebra
Map algebra uses a predefined, mathematical formula applied to the corresponding cells of overlaid themes to 
create a new theme with the numerical result assigned to the cell. The formula used in map algebra can be a simple 
mathematical operation like addition, multiplication, division or subtraction (arithmetic operators), Boolean operators 
(‘and’, ‘or’, or ‘not’) and it can also use a more complex operation involving logarithms, exponents, powers and 
trigonometric functions such as sine and cosine (mathematical functions).

In this exercise we will use some simple analysis to make the tool familiar.

zz In the ArcToolbox, go to ‘Spatial Analyst Tools > Map Algebra’ and double click on ‘Raster Calculator’. The 
‘Raster Calculator’ window will open.
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Now we are just going to identify the higher elevation areas above 4,000 metres in Bhutan. To do this:
zz In the ‘Raster Calculator’ window, double click on ‘Dem45N.tif’ in the Layers and Variables box on the left side 

of the window. This will add the ‘Dem45n.tif’ layer name in the expression box below the layers selection box.
zz Click on the ‘Greater Than’ sign and type ‘4000’ in the expression box as shown in the figure above.
zz Under the ‘Output Raster’, click on the folder icon and navigate to the folder ‘C:\TrainingData\GIS\temp’, then 

name the output file ‘Elev_above4000.tif’ and click the ‘Save’ button to close the window.
zz Click the ‘OK’ button to process and close the window. You will see a little process window at the bottom of the 

screen, and when the process is complete a new layer is added in the project.

Now you can see the ‘Elev_above4000.tif’ layer in the Map view, as shown in the figure below. The output data 
is categorised into two classes with the cell or pixel value of ‘0’ and ‘1’ respectively. Change the symbology of 
the value ‘0’ to ‘Hollow’ and value ‘1’ to ‘dark blue’ color. In the figure below, the value ‘1’ is in dark blue color 
representing the area above 4,000 metre elevation.

Let’s combine the two raster with conditions for slope below 55 degrees and elevation above 4,000 metres. 
For example, just assume that glaciers mostly occur in elevations above the 4,000 metres and slopes below 55 
degrees. 

zz Open the ‘Raster Calculator’ window by double clicking on the ‘Raster Calculator’ tool in the ArcToolbox.
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zz Double click on the layers in the ‘Layers and Variables’ box, and using the buttons in the ‘Raster Calculator’ 
window enter the expression as (‘Dem45N.tif’ > 4000) & (‘slope.tif’ < 55) in the expression box.

zz Under the ‘Output Raster’, click on the folder icon and navigate to the folder ‘C:\TrainingData\GIS\temp’, then 
name the output file ‘Elev4000_slp55.tif’ and click ‘Save’ to close the window.

zz Click ‘OK’ to process and close the window. You will see a little process window at the bottom of the screen, 
and when the process is complete a new layer is added in the project.

zz Now you can see the ‘Elev4000_slp55.tif’ layer in the Map view, as shown in the figure below. The output data 
is categorised into two classes with the cell or pixel value of ‘0’ and ‘1’ respectively. Change the symbology of 
the value ‘0’ to ‘Hollow’ and value ‘1’ to ‘dark green’ color and compare the result with the previous one.
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Before calculating the glacier database, the glaciers, which are mapped using the Definiens eCognition Software, 
are exported to the shapefiles and the polygons of the glaciers are prepared according to the standards of the 
World Glacier Inventory. For this exercise, we have provided the glacier polygon of Langtang area given in the 
training data folder including DEM of Langtang area. The glacier shapefile name is ‘Langtang_Glacier_2009.shp’. 

Add Glacier Layer
zz To add a glacier polygon layer in the ArcMap, go to File > Add Data and click on , or 

alternatively, click the Add Data button  in the Standard toolbar. The Add Data dialog box appears.

zz Navigate the location (C:\TrainingData\Glacier_mapping\shp\) of the Glacier data and select the ‘Langtang_
Glacier_2009.shp’ file and click the Add button. The glacier layer appears in the ‘Data View’ window.

3. Calculation of Geo-Statistical Database of 
Glaciers
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Open Attribute Table
To open the ‘Attribute Table’ of the glacier layer, select the ‘glacier’ layer in the ‘Table of Contents’ window and 
right-click on the glacier layer. Then click on the ‘Open Attribute Table’ in the context menu. The Attribute Table of the 
glacier layer opens. 

Assign the Local ID 
The Local ID is given based on the basin and sub-basin name and counting starts from the outlet of the major stream 
of the sub-basin, then proceeds clockwise round the basin, as mentioned in Mool et al. 2001. For example, if the 
Local ID is ‘Tlagr09_10’, the first letter ‘T’ stands for Trishuli basin, ‘la’ stands for Langtang sub-basin, ‘gr’ stands for 
glacier, ‘09’ represents year 2009 from which the glacier boundary was mapped and number ‘10’ represents the 
number of glaciers in the Langtang sub-basin. The step-by-step process for assigning a local ID to each glacier is 
described below. This exercise is just to give you a sense of the Local ID but it is not in practice nowadays.

zz Click the down arrow button in ‘Table Options’  in the top row of the ‘Attribute Table’ window and click on 
‘Add Field’ from the context menu of Table Options. The ‘Add Field’ dialog box appears. 

zz Enter ‘Local_ID’ in the ‘Name’ textbox of the ‘Add Field’ sub-window.
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zz For ‘Type’, select ‘Text’ from the dropdown menu.
zz Assign the Length of the field in the ‘Field Properties’ column of the ‘Add Field’ window and click ‘OK’ to confirm. 

The new field ‘Local_ID’ appears in the last column of the attribute table of the glacier layer.

To Assign a Local ID to Each Glacier, Perform the Following Steps
zz To assign the Local_ID, the data should be in editing mode. Click on Customize menu in the Menu bar and go 

to Toolbars then select the Editor from the listto open the Editor Toolbar.
zz Click on down arrow in the ‘Editor Toolbar’ and click on the ‘Start Editing’ in the context menu. Now the data is 

in editing mode.
zz Click on the ‘Select Features’ button in the ‘Tools’ toolbar and click on the individual glacier polygon in the ‘Data 

View’ window. The selected glacier is highlighted in the ‘Data View’ window as well as in the ‘Attribute Table’.
zz Assign the Local ID as ‘TLagr09_1’ in the highlighted cell of the ‘Local_ID’ field in Attribute Table, or alternatively 

click the Attribute button in the ‘Editor’ toolbar; when the ‘Attributes’ dialog box opens, assign the glacier a Local 
ID ’TLagr09_1’ in the ‘Local_ID’ field in the ‘Attributes’ dialog box.
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Note: First digit of Local Id: first letter of Basin; Second two digit: first two letter of the Sub-basin, gr indicates 
Glacier; 09 indicates Year and 1 indicates glacier number in clockwise rotation of drainage in the sub-basin.

zz Likewise, select others glaciers in the basin and assign the each of them a Local ID.
zz After all the glaciers have been assigned IDs, click on the Editor button in the Editor toolbar and click on the 

Save Edits to save the assigned data. Then click on Editor button again and click on Stop Editing to stop the 
editing mode.

3.2	 GLIMS ID
The GLIMS ID is based on the latitude and longitude location of a “centre point” on the glacier. The GLIMS ID is 
a 14-digit code where G stands for Global, E for East and N for North. The latitude and longitude should be in 
degreesdefined to three decimal places. The format of the GLIMS ID is GXXXXXXEYYYYYN where G – Global, 
XXXXXX and YYYYY are longitude and latitude values defined to three decimal places after removing the decimal. For 
example, the GLIMS ID of the Lirung glacier is G085547E28252N.

To calculate the GLIMS ID, first we need to generate the points of the glaciers polygon by using “Feature to Point” 
tool in the toolbox “Data management tools>Features”. The point features generated were re-checked to confirm 
that the points lie at the centre of the glaciers. If the points are inside the glacier polygon rather than at the centre, 
activate the Editing mode and move the points manually to the centre or inside the glacier polygon. Once all the 
points are located at the centre of the glacier, calculate the longitude and latitude values of the points by adding 
the field named as Longitude and Latitude as field type ‘double’ and precision and scale properties of the fields as 
8 and 3 respectively. This is the overall process for calculating the centre coordinates of the glacier polygons. But 
in this exercise we will directly calculate the longitude and latitude of the centroid of the glacier polygon, which is 
described step by step below.

Calculate the Latitude and Longitude
To calculate the Latitude and Longitude of the individual glaciers, the data (glacier shapefile) should be in 
geographic coordinate systems. But in the latest version (10.x) of ArcGIS, you can directly calculate the Latitude 
and Longitude by using the projection system of the data frame. So, to calculate the Latitude and Longitude of the 
glaciers, you have to either change the projection of the glacier shape file into geographic coordinate system or 
change the projection system of the data frame. To change the projection system of the data frame, perform the 
following steps:
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zz Open the properties of the data frame by double clicking on the data frame name (Layers) or right clicking on the 
data frame (Layers) and select Properties from the list menu.

Now the ‘Data Frame Properties’ window will appear. Typically the coordinate system of the data frame is set by 
the coordinate system of the first dataset added to the map and all other added datasets will be projected on the fly 
to match the same coordinate system. You can review 
and change the coordinate system of the data frame. 
In this exercise, to set the coordinate system of the data 
frame is set to Geographic coordinate system.

zz Select the ‘Coordinate System’ tab on the ‘Data 
Frame Properties’ window.

zz Navigate to ‘Geographic Coordinate Systems > 
World’ in the list box of coordinate system and 
select the ‘WGS 1984’ from the world list.

zz Click ‘OK’ to set the projection system of the data 
frame.

Now, you can calculate the longitude and latitude of 
the centroid of glacier polygon. 

zz If the ‘Attribute Table ‘of the glacier layer is not 
opened, open it by right-clicking on the glacier 
layer in the ‘Table of Contents’ window and click 
on the ‘Open Attribute Table’ from the context 
menu.

zz Click on the down arrow of the ‘Table Options’ 
button  in the top row of the ‘Attribute Table’ 
window and click on ‘Add Field’ from context 
menu. The ‘Add Field’ dialog box appears. 

zz Assign the field name ‘Latitude’ in the ‘Name’ 
textbox of ‘Add Field’ dialog box.

zz Select field type as ‘Double’ from the ‘Type’ 
dropdown menu.
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zz Assign the ‘Precision’ as ‘6’ and ‘Scale’ as ‘3’ in the ‘Field 
Properties’ column of ‘Add Field’ dialog box and click the OK 
button to confirm. The new field ‘Latitude’ appears in the last 
column of the attribute table after ‘Local ID’ field.

zz Similarly add the field ‘Longitude’.
zz To calculate the latitude of the glacier, right-click on the ‘Latitude’ 

field and click on the ‘Calculate Geometry’ from the context 
menu. The ‘Calculate Geometry’ dialog box appears.

zz Select the ‘Y Coordinate of Centroid’ in the ‘Property’ dropdown 
menu.

zz Click the ‘OK’ button to calculate the latitude of the glaciers.

zz Similarly calculate the ‘Longitude’ of the glaciers.
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Assign GLIMS ID
Before assigning the GLIMS ID, calculation of Latitude and Longitude should be completed. To assign the GLIMS ID, 
perform the following steps:

zz Click on the down arrow of the ‘Table Options’ button  in the top row of the ‘Attribute Table’ window and 
click on ‘Add Field’ from the context menu of ‘Table Options’. The ‘Add Field’ sub-window will appear. 

 

zz Assign the field name ‘GLIMS_ID’ in the ‘Name’ textbox of Add Field sub-window.
zz Select field type as ‘Text’ from the ‘Type’ dropdown menu.
zz Set the field length to ‘16’ in the ‘Field Properties’ column of the ‘Add Field’ dialog box and click on ‘OK’ to 

confirm. The new field ‘GLIMS_ID’ appears in the last column of the attribute table after the ‘Longitude’ field.
zz To calculate ‘GLIMS ID’, right-click on the ‘GLIMS_ID’ field and click on ‘Field Calculator’ 

 in the context menu. The ‘Field Calculator’ dialog box appears.
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zz Assign the formula “G0”& [Longitude]*1000&”E”& 
[Latitude]*1000&”N” in the ‘GLIMS_ID’ textbox in 
‘Field Calculator’ dialog box using ‘Mathematical 
Operator’ buttons and Field name lists.

zz Click ‘OK’ to calculate the ‘GLIMS ID’ of the 
glaciers.

3.3	 Glacier Area
It represents the aerial surface area covered on the 
ground. It will be calculated separately for clean ice 
(CI) and debris covered (DC) glaciers and later the 
area will be merged to obtain the total glacier area. 
The area of the polygon in ArcMap is calculated 
using calculate geometry function directly in the field 
properties. To calculate the area, the dataset needs 
to be projected into a projected coordinate system. 
For the exercise, the training data (“Langtang_
Glacier_2009.shp”) is already projected in UTM 45N 
zone, so you can directly calculate the area on it. If 
your data is not projected into a projected coordinate 
system, you need to either project your data or you can change the projection system of the data frame into a 
projected coordinate system, as in the previous exercise. To carry out the exercise, perform the following steps.

Click on the down arrow of the ‘Table Options’ button  in the top row of the ‘Attribute Table’ window and click on 
‘Add Field’ from the context menu of ‘Table Options’. The ‘Add Field’ sub-window will appear. 
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zz Assign the field name ‘Area_sqKM’ in the ‘Name’ textbox of ‘Add Field’ sub-window.
zz Set ‘field type’ as ‘Double’ from the ‘Type’ dropdown menu.
zz Set the ‘Precision’ to ‘8’ and ‘Scale’ to ‘3’ in the Field Properties column of ‘Add Field’ dialog box and click the 

‘OK’ button to confirm. The new field ‘Area_sqKM’ appears in the last column of the attribute table after ‘GLIMS_
ID’ field.

zz To calculate the area of the glaciers, 
right-click on the ‘Area_sqKM’ field 
and click on the ‘Calculate Geometry’ 
from the context menu. The ‘Calculate 
Geometry’ dialog box appears.

zz Select the ‘Area’ in the ‘Property’ 
dropdown menu and select the ‘Square 
Kilometres (sq.km.)’ from the ‘Units’ 
dropdown menu to calculate the area of 
the glacier in square kilometres. 

zz Click the ‘OK’ button to calculate the 
area of the glacier.

Now you can see the area of each glacier 
polygon in the Area_sqKm field. Double 
click on the Area_sqKm field; the values 
on the area field will be arranged in ascending order. Note down the first value of area in the first row, which 
is the smallest glaciers in the datasets. Again double click on the Area_sqKm field; the data will be arranged in 
descending order. Note down the largest glacier area from the first row in the table.

3.4	 Glacier Elevation
The elevation of glacier represents the altitudinal extent of the glacier. It is calculated based on the SRTM DEM of 
spatial resolution of 90 m. Three levels of elevation data are calculated in the glacier inventory - highest elevation 
representing the highest elevation of the crown of the glacier mostly lies in the clean ice (CI) part; mean elevation is 
calculated as the average values of all the pixels associated with the glacier boundary in DEM; and lowest elevation 
representing the elevation of the tongue of the glacier derived from the debris covered ice. If the glacier is not debris 
covered, the tongue of the clean ice is considered to be the lowest elevation. It is measured in metres above sea 
level (masl).

In this exercise, we will use the SRTM DEM of the Langtang area provided in the training datasets. Zonal statistics 
tool built in the Spatial Analyst tool is used to calculate the statistics of each glacier polygon, using GLIMS ID as a 
reference. The elevation value of each glacier is calculated in a separate table, which will be joined later, and the 
required values (Min, Mean and Max) will be transferred to the glacier polygon dataset (shapefile). To calculate the 
elevation values of the glacier, follow the steps given below. 

Add Dem 
zz Click on ‘Add Data’ button  in the ‘Standard’ toolbar. The Add Data dialog box appears.
zz Navigate the location (C:\TrainingData\Glacier_mapping\Dem\) from ‘Look in’ dropdown menu and select the 

‘Dem’ (Dem.img) file and click the ‘Add’ button. The ‘Dem’ layer appears in the ‘Data View’ window.
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Activate Spatial Analyst Extension
zz To calculate the elevation of the glacier from the raster elevation data, the 

‘Spatial Analyst’ extension has to activate. Click on the ‘Customize’ menu in 
the Menu bar and click on the ‘Extension…’ menu from the context menu. 
The ‘Extension’ dialog box appears. 

zz Check the ‘Spatial Analyst’ from the list in the ‘Extension’ dialog box to 
activate the Spatial Analyst extension and click the ‘Close’ button to close 
the ‘Extension’ dialog box.

Calculate Elevation of the Glaciers
zz Now click on ‘ArcToolbox’ icon  in the ‘Standard’ toolbar to open 

‘Arctoolbox’.
zz Expand the ‘Spatial Analyst Tools > Zonal’ and click on ‘Zonal Statistics as 

Table’. The ‘Zonal Statistics as Table’ dialog box opens.

zz In the ‘Zonal Statistics as Table’ Wizard, select ‘glacier’ layer in the ‘Input Raster or feature zone data’, ‘GLIMS_
ID’ field in ‘Zone Field’ and select raster ‘Dem’ data in ‘Input value raster’ column.

zz Click on the ‘folder’ icon  next to Output Table. The ‘Output Table’ dialog box appears. Locate the location 
for the file to be saved and name the file ‘Elevation.dbf ‘and click ‘OK’ to confirm.

zz Check ‘Ignore NoData’ in calculation.
zz For ‘Statistics Type’, select ‘All’ and click ‘OK’ to calculate the elevation of glaciers.

Add Fields in Glacier Layer
Open ‘attribute table’ of the glacier layer and ‘Add Fields’ – ‘Elv_min’, ‘Elv_mean’ and ‘Elv_Max ‘in the atttibute 
table of the glacier layer.

Join Elevation Table
zz Join the ‘Elevation.dbf’ table to glacier layer.
zz To join the table right click on ‘Glacier File’ and select ‘Join and Relates’ from the context menu and click on 

‘Join’. The ‘Join Data’ dialog box appears.
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zz Select the ‘GLIMS_ID’ field in ‘1’ dropdown menu. 
Select table ‘(Elevation.dbf)’ layer in the ‘2’ dropdown 
menu and select the same field ‘GLIMS_ID’ in the ‘3’ 
dropdown menu.

zz Under ‘Join options’, select ‘Keep all records’ and click 
the ‘OK’ button to join the table.

Shifting Elevation Data of the Glacier into the Glacier 
Layer from the Joined Table 

zz Now right-click on ‘Elv_min’ field in the Attribute 
Table of glacier layer and click on ‘Field Calculator’ 

 in the context menu. The 
‘Field Calculator’ dialog box appears.

zz Assign the Field ‘MIN’ of the joined table ‘Elevation.dbf’ 
in the ‘Elv_min’ textbox from the ‘Field Name’ lists in the 
‘Field Calculator’ dialog box.

zz Click ‘OK’ to confirm. The ‘Minimum elevation’ of the 
glacier is assigned from the joined table into the glacier 
layers.

zz Similarly assign the ‘Mean’ and ‘Maximum’ elevation of 
glacier from the joined table to the glacier layer.

zz Remove the joined table from the glacier layer. To 
remove the joined table, right click on glacier layer and 
select ‘Join and Related’ from the context menu. Select ‘Remove Joins’ from the ‘Join and Related’ context menu 
and click on the joined table ‘Elevation’. The joined table removedfrom the glacier layer.

Arrange the maximum elevation values in descending order by double clicking on “Elv_Max” twice and note down 
the respective GLIMS ID and elevation value from the topmost row in the arranged attribute table as the highest 
elevation extent glaciers. Find out the lowest elevation glacier by clicking on the “Elv_min” field. Similarly, find out the 
extent of the glaciers in the Langtang sub-basin.
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3.5	 Glacier Slope 
Slope of the glacier is also an important parameter as it helps us characterize various morphological conditions of 
the glacier. It is derived for each glacier from the DEM. Slope is generated using the slope model built in the Spatial 
Analyst tools in arcgis using SRTM DEM. 

Activate Spatial Analyst Extension
To generate the slope and calculate the slope of glacier from the raster slope data, the ‘Spatial Analyst’ extension 
has to activate. If you have already activated the Spatial Analyst, you don’t need to follow these steps.

zz Click on ’Customize’ menu in the Menu bar and click on Extension… menu from the context menu. The Extension 
dialog box appears. 

zz Check on ‘Spatial Analyst’ on the list in the ‘Extension’ dialog box to activate the Spatial Analyst extension and 
click the ‘Close’ button to close the ‘Extension’ dialog box.

Create Slope Data from DEM
zz Click on ‘Arc Toolbox’  in the standard toolbar to open Arctoolbox
zz Expand the ‘Spatial Analyst Tools > Surface’ and double click on ‘Slope’. The Slope wizard opens.

 

zz In the slope wizard, select ‘Dem’ in ‘Input Raster’, click on ‘Folder’ icon  next to ‘Output Raster’. The Output 
Raster dialog box opens. Select the location of the file to be saved and name the file ‘Slope.tif ‘and click the 
‘OK’ button to confirm.

Note that if you ‘Dem’ data in a geographic coordinate system, you have to first change it into a projected 
coordinate system. For this exercise, change the projection of the “Dem” to “UTM WGS 1984 45N”. Then create 
the slope and aspect data.

zz Select ‘Output Measurement’ as ‘DEGREE’ and ‘Z-factor’ as ‘1’. 
zz Click the ‘OK’ button in the Slope wizard to calculate Slope. The Slope layer appears in the Data View window.

Calculate Slope of the Glaciers
zz Now click on the ‘ArcToolbox’ icon  in the ‘Standard’ toolbar to open ‘Arctoolbox’.
zz Expand the ‘Spatial Analyst Tools > Zonal’ and click on ‘Zonal Statistics as Table’. The ‘Zonal Statistics as Table’ 

dialog box opens.
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zz In the ‘Zonal Statistics as Table’ wizard, Select ‘glacier layer’ in the ‘Input Raster or feature zone data’, ‘GLIMS_
ID’ field in ‘Zone Field’ and select raster ‘Slope’ data in ‘Input value raster’ column.

zz Click on ‘Folder’ icon  next to ‘Output Table’. The Output Table dialog box appears. Select the location of the 
file to be saved and name the file ‘Slope.dbf ‘ and click ‘OK’ to confirm.

zz Check ‘Ignore NoData in calculation’
zz Select ‘Statistics Type’ as ‘Mean’ and click ‘OK’ to calculate the Slope of glaciers.

Add Fields in Glacier Layer
zz Open ‘attribute table’ of the glacier layer and ‘Add Fields’ - ‘Slp_min’, ‘Slp_mean’ and ‘Slp_Max’ in the 

‘Attribute table’ of the glacier layer.

Join Elevation Table
zz Join the ‘Slope.dbf’ table to glacier layer.
zz To join the table right click on ‘Glacier File’ and select ‘Join and Relates’ from the context menu and click on 

‘Join’. The Join Data dialog box appears.
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zz Select the ‘GLIMS_ID’ field in ‘1’ dropdown menu. 
Select Table (‘Slope.dbf’) layer in ‘2’ dropdown menu 
and select the same field ‘GLIMS_ID’ in ‘3’ dropdown 
menu.

zz Under ‘Join options’, select ‘Keep all records’ and click 
the ‘OK’ button to join the table.

Shifting Slope Data of Glacier into the Glacier Layer 
from Joined Table 

zz Now right-click on ‘Slp_min’ field in the Attribute 
Table of glacier layer and click on ‘Field Calculator’  

in the context menu. The 
‘Field Calculator’ dialog box appears.

zz Assign the Field ‘MIN’ of the joined table ‘Slope.dbf ‘ 
in the ‘Slp_min’ textbox from the ‘Field Name’ lists in the 
‘Field Calculator’ dialog box.

zz Click ‘OK’ to confirm. The ‘Minimum’ slope of glacier is 
assigned from the joined table into the glacier layers.

zz Similarly assign the ‘Mean’ and ‘Maximum’ slope of 
glacier from the joined table to the glacier layer.

zz Remove the joined table from the glacier layer. To 
remove the joined table, right click on glacier layer and 
select ‘Join and Related’ from the Context menu. Select 
‘Remove Joins’ from the ‘Join and Related’ context menu 
and click on the joined table ‘Slope’. The joined table is removed from the glacier layer.

Similarly calculate the ‘mean’ aspect value of the glaciers.

3.6	 Hypsography of Glaciers
Hypsography is the study of the distribution of elevations on the surface of the earth (glacier/lands). The term 
originates from the Greek word ὕψος ‘hypsos’, which means height. It is the calculation of glacier specific area-
elevation distribution and can be easily obtained by combining glacier outlines with the DEM. This information would 
greatly improve the calculation of future glacier response to climate change, as glacier melt (and precipitation) is 
largely elevation dependent. A 100 m binning is recommended to have some consistency in the database and to 
cover the large range of possible values without losing relevant information on smaller glaciers.

Methodology

Adding DEM 
and Glacier 
Boundary

Add field and 
calculate area

Clipping the 
DEM by Glacier 
Boundary

Summarize the 
calculate area 
and export data

Reclassify the 
Clipped DEM

Create graphs 
for analysis

Convert to 
Classified Dem 
to Features
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Detailed Steps for Hypsography Analysis of Glaciers Using ARCGIS 10

Add Raster Data (DEM) and Feature Data (Shape file) of Glacier Boundary
zz Go to ‘File > Add Data > Add Data…’ Or click on 

Clip DEM by Glacier Boundary
zz In order to clip the ‘DEM’, open the ‘Arc Toolbox’ .
zz Go to ‘Data Management Tools> Raster>Raster Processing’ and double click on Clip.
zz In the clip panel, ‘add DEM in Input Raster columns’ and add ‘glacier boundary file in Output Extent’.
zz Check ‘Use input Feature for Clipping Geometry (Optional)’.
zz Select the output path in ‘Output Raster Dataset’.
zz Then click ‘OK’.

Reclassify the Clipped DEM in 100 m Bin
zz Open ‘Arc Toolbox’  and go to ‘Spatial Analyst Tools > Reclass’ 
zz Double click on ‘Reclassify’ to open ‘Reclassify’ sub-window
zz Add clipped DEM in Input ‘Raster’ column and select ‘Reclass’ Field from the ‘Reclass’ field dropdown menu.
zz Now define the 100 m class interval in ‘Old values’ column and also the ‘New values’ in Reclassification to 

reclassify the DEM. Define the ‘Old Values’ and ‘New Values’ as follows
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S.N. Old values New values
1 4,000–4,100 4,041

2 4,100–4,200 4,142

3 4,200–4,300 4,243

4 4,300–4,400 4,344

5 No Values No Values

zz And define the output file path in ‘Output Raster’.
zz Then click ‘OK’.

Convert Classified DEM into Features
zz Open ‘Arc Toolbox’ .
zz Go to ‘Conversion Tools > From Raster’.
zz Double click on ‘Raster to Polygon’ to open the sub window.
zz Add Reclassified ‘DEM’ in ‘Input Raster’ and specify the output polygon 

file in ‘Output Polygon Features’.
zz Click ‘OK’. 
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Add Field and Calculate Area in Feature

Adding Field in Attribute Table
zz Add the ‘Reclassified polygon’ feature data 
zz Right click on the ‘Reclassified Polygon’ feature in the ‘Table of Contents’ Column and click on ‘Open Attribute 

Table’. 
zz Go to ‘Table Option’  in the ‘Attribute table’ and click on ‘Add Field’.

zz Type ‘Name’ of the ‘Field’ (Area) in the ‘Name’ textbox in Add field window and select ‘Double’ under ‘Field 
Type’; then set the ‘Precision’ to ‘10’ and ‘Scale’ to ‘3’ in the Field Properties column.

zz And click ‘OK’. 

Calculate Area
zz Right click on the ‘Field Title’ (area) in the attribute table.
zz Go to ‘Calculate Geometry’. 
zz Select ‘Area’ from the ‘Properties’ dropdown menu and specify the unit from the ‘Units’ dropdown menu and click 

‘OK’.
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Note: To calculate area the data should be in a 
projected coordinate system. So first the data should 
be converted into a projected coordinate system as 
“UTM WGS 1984 45N”.

Export the Summarize Attribute Data
zz Open the ‘Attribute Table’ of the ‘Polygon Feature’ 

data.
zz Right click on ‘GRIDCODE’ field and click on 

‘Summarize’ menu.
zz In the ‘Summarize’ window, select ‘GRIDCODE’ 

field to summarize.
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zz Check the ‘SUM’ into the Area field in the selection menu.
zz Specify the output table path and click ‘OK’.

Create and Export Charts
zz Add summarized data 

zz Open the ‘Attribute Table’. 

zz Click the down arrow in ‘Table Option’  and 
go to ‘Create Graph’ 

zz In the ‘Create Graph’ Wizard, select the following 
items in their respective columns.

zz For ‘Graph Type’, select ‘Vertical Line’.

zz Select ‘Layer/Table’ that will be used to create a 
graph.

zz Select ‘Y field’ as ‘GRIDCODE’ and ‘X field’ as 
‘Area’.

zz Then click ‘Next’.
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zz In the next panel define the ‘Graph Title’ in ‘General Graph Properties’ column and ‘Axis Title’ in ‘Axis Properties’ 
column by selecting Left and Bottom Tab.

zz Then click ‘Finish’.
zz Right-click on the ‘Graph’ and choose ‘Advanced Properties…’ to further refine the graph; 
zz OR choose ‘Export…’ to export it into JPEG format;
zz OR choose ‘Add to Layout’ to add it in a layout; and
zz OR choose ‘Print…’ to print it.
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